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Spreadsheet Link Product Description

1-2

Use MATLAB from Microsoft Excel

Spreadsheet Link connects Excel® spreadsheet software with the MATLAB® workspace,
enabling you to access the MATLAB environment from an Excel spreadsheet. With
Spreadsheet Link software, you can exchange data between MATLAB and Excel, taking
advantage of the familiar Excel interface while accessing the computational speed and
visualization capabilities of MATLAB.

Key Features

+ Data preprocessing, editing, and viewing in the familiar Excel environment
* Sophisticated analysis of Excel data using MATLAB and application toolboxes

* Delivery of Excel based applications, using MATLAB as a computational and graphics
engine and Excel as an interface

+ Interactive selection of available functions using the MATLAB Function Wizard

* Visual interface for customization of all Spreadsheet Link preferences



Microsoft Excel and MATLAB Interaction

Microsoft Excel and MATLAB Interaction

Spreadsheet Link Add-In integrates the Microsoft Excel and MATLAB products in a
computing environment running Microsoft Windows®. It connects the Excel interface to
the MATLAB workspace, enabling you to use Excel worksheet and macro programming
tools to leverage the numerical, computational, and graphical power of MATLAB.

You can use Spreadsheet Link functions in an Excel worksheet or macro to exchange and
synchronize data between Excel and MATLAB, without leaving the Excel environment.
With a small number of functions to manage the link and manipulate data, the
Spreadsheet Link software is powerful in its simplicity.

The Spreadsheet Link software supports MATLAB two-dimensional numeric arrays,
character vectors, and two-dimensional cell arrays. It does not work with MATLAB
multidimensional arrays and structures.

Related Examples
. “Work with MATLAB Functions in Microsoft Excel” on page 1-17
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Installation

1-4

In this section...

“Product Installation” on page 1-4
“Files and Folders Created by the Installation” on page 1-4

“After You Upgrade the Spreadsheet Link Software” on page 1-4

Product Installation

Install the Microsoft Excel product before you install the MATLAB and Spreadsheet Link
software. To install the Spreadsheet Link Add-In, follow the instructions in the MATLAB
installation documentation. Select the Spreadsheet Link check box when choosing
components to install.

Notes: If you have several versions of MATLAB installed on your computer, Spreadsheet
Link uses the version that you registered last.

To install the Spreadsheet Link Add-In, you need administrator system privileges on the
computer. Contact your system administrator to enable these privileges.

Files and Folders Created by the Installation

Note: The MATLAB root folder, matlabroot, is where MATLAB is installed on your
system.

The Spreadsheet Link installation program creates a subfolder under
matlabroot\toolbox\. The exlink folder contains these files:

+ excllink.xlam: The Spreadsheet Link Add-In for Microsoft Excel
+ ExBiSamp.xls: Spreadsheet Link example files described in this documentation

After You Upgrade the Spreadsheet Link Software

If MATLAB and Spreadsheet Link are installed on your computer, to upgrade to a newer
version:




Installation

Install the new version of MATLAB and Spreadsheet Link.
Start MATLAB and a Microsoft Excel session.

Configure the Spreadsheet Link software. For details, see “Add-In Setup” on page
1-6.

If you have existing workbooks with macros that use Spreadsheet Link, update
references to Spreadsheet Link in each workbook.

To update the references in an existing workbook in Microsoft Excel:

1

O b WD

In a Microsoft Excel session, open the Visual Basic® Editor window by clicking
Visual Basic on the Developer tab. (If you do not find the Developer tab, see the
Excel Help.)

In the left pane, select a module for which you want to update a reference.

From the main menu, select Tools > References.

In the References dialog box, select the SpreadsheetLink2007_2010 check box.
Click OK.

More About

“Add-In Setup” on page 1-6
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Add-In Setup

1-6

In this section...

“Configure Microsoft Excel” on page 1-6
“Work with the Microsoft Visual Basic Editor” on page 1-10

Configure Microsoft Excel

To enable the Spreadsheet Link Add-In, start a Microsoft Excel session and follow these
steps.

If you use Microsoft Excel 2007:

Click ", the Microsoft Office button.
2 Click Excel Options. The Excel Options dialog box opens.

If you use Microsoft Excel 2010 and later versions:

1 Select File from the main menu.

2 Click Options. The Excel Options dialog box opens.

The next steps are the same for both versions:

Click Add-Ins.

From the Manage selection list, choose Excel Add-Ins.
Click Go. The Add-Ins dialog box opens.

Click Browse.

Select matlabroot\toolbox\exlink\excllink.xlam.

Click Open. In the Add-Ins dialog box, the Spreadsheet Link for use with
MATLAB and Excel check box is selected.

o O A WD —~



Add-In Setup

Add-Ins

Add-Ins available:

[] Analysis ToolPak - oK
[] Analysis ToolPak - VBA

|:|Eur::| Currency Tools Cancel

[ salver Add-in

Spreadsheet Link 3.2.5 for use with MATLAE and Excel Browse...

1 §

Automation...

Spreadsheet Link 3.2.5 for use with MATLAE and Excel
Spreadsheet Link 3.2.5 for use with MATLAE and Excel

7 Click OK to close the Add-Ins dialog box.
8 Click OK to close the Excel Options dialog box.

The Spreadsheet Link Add-In loads now and with each subsequent Excel session.

The MATLAB Command Window button appears on the Microsoft Windows taskbar.

The MATLAB group appears on the top right of the Home tab in your Excel worksheet.
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Add-In Setup
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Work with the Microsoft Visual Basic Editor

To enable Spreadsheet Link as a Reference in the Microsoft Visual Basic Editor:

1 Open a Visual Basic session. Click the Visual Basic button on the Developer tab,
or press Alt+F11.

Note: For instructions about displaying the Developer tab, see Excel Help.

2 In the Visual Basic toolbar, select Tools > References.

3 In the References — VBA Project dialog box, select the SpreadsheetLink or
SpreadsheetLink2007_2010 check box.

4 Click OK.

See Also

matlabroot

More About

. “Installation” on page 1-4
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Setting Spreadsheet Link Preferences

In this section...

“Work with the Preferences Dialog Box” on page 1-11
“Work with Preferences in Worksheet Cells” on page 1-12

To work with Spreadsheet Link and MATLAB, set preferences that control how
Spreadsheet Link and MATLAB behave when Spreadsheet Link starts MATLAB in
Microsoft Excel. You can set these preferences using the Preferences dialog box or using
worksheet cells in Microsoft Excel.

Work with the Preferences Dialog Box

You can set Spreadsheet Link preferences using the Preferences dialog box.

1 Click Preferences in the MATLAB group. The MATLAB group appears on the top
right of the Home tab in your Excel worksheet.

The Preferences dialog box appears.

1-11
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o

Preferences

[ istart MATLAE at Excel startup

MATLAE program id

| 2.0

MATLAE startup folder

B =

[™ Use MATLAB desktop

[~ Show MATLAE errors

r Force use of MATLAB cell arrays with
MLPutMatrix

[ Treat missing/empty cells as MNaM

Ok Cancel

2 To set preferences, click the check box next to a preference or enter text into a
box. For the MATLAB program id, enter the MATLAB version as shown in the
Windows registry. For the MATLAB startup folder, enter the full path of the

startup folder.

Work with Preferences in Worksheet Cells

To set a preference in a worksheet cell in Microsoft Excel, enter text that runs the
corresponding Spreadsheet Link function in the worksheet cell. For example, to set the

MATLAB version in a worksheet cell:

1  Enter this text in any worksheet cell. This text sets the MATLAB version to 9.0 that

corresponds to MATLAB R2016a.



Setting Spreadsheet Link Preferences

=MLProgramld(*'9.0")

A B
1 |:MLPngramld|{”5.D“}|

2 To run the function, press enter.

For details, see MLProgramld.

See Also
MLPutMatrix

More About

. “Worksheet Cell Errors” on page 3-2
. “Startup Errors” on page 3-11
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Start and Stop Spreadsheet Link and MATLAB
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In this section...

“Start Spreadsheet Link and MATLAB Automatically” on page 1-14
“Start Spreadsheet Link and MATLAB Manually” on page 1-14
“Connect to an Already Running MATLAB Session” on page 1-14
“Specify the MATLAB Startup Folder” on page 1-15

“Stop Spreadsheet Link and MATLAB” on page 1-16

Start Spreadsheet Link and MATLAB Automatically

When installed and configured according to the instructions in “Add-In Setup” on page
1-6, the Spreadsheet Link and MATLAB software automatically start when you start a
Microsoft Excel session.

Start Spreadsheet Link and MATLAB Manually

1 Select Tools > Macro.

+ In Excel 2007, click the View or Developer tab, and then click the Macros
button.

+ In Excel 2010, click the View menu and select Macros on the Excel toolstrip, and
then click View Macros.

2 Enter matlabinit into the Macro Name/Reference field.

3 Click Run. The MATLAB Command Window button appears on the Microsoft
Windows taskbar.

Connect to an Already Running MATLAB Session

By default, Spreadsheet Link starts a new MATLAB session. Alternatively, it can
connect to an already running MATLAB session.

Note: If several versions of MATLAB are installed on your computer, Spreadsheet
Link always uses the last registered version. If you try to connect to an already running
MATLAB session that is not the last registered version, Spreadsheet Link starts a new



Start and Stop Spreadsheet Link and MATLAB

MATLAB session. Spreadsheet Link does not connect to the existing one. To change the
last registered version, see “Startup Errors” on page 3-11.

To connect a new Excel session to an already running MATLAB session:

1 In MATLAB, enter the following command:

enableservice("AutomationServer"®,true)

This command converts a running MATLAB session into an Automation server.

2 Start a new Excel session. It automatically connects to the running MATLAB
session.

Alternatively, you can start MATLAB as an automation server from the beginning. To
start MATLAB as an automation server, use the automation command-line option:

matlab -automation

This command does not start MATLAB in a full desktop mode. To do so, use the -
desktop option:

matlab -automation -desktop

If you always use MATLAB as an automation server, modify the shortcut that you use to
start MATLAB:

1 Right-click your MATLAB shortcut icon. (You can use the icon on your desktop or in
the Windows Start menu.)

2 Select Properties.
Click the Shortcut tab.

4 Add -automation in the Target field. Remember to leave a space between
matlab.exe and —automation.

5 Click OK.

w

For details, see “Manually Create Automation Server”.

Specify the MATLAB Startup Folder

MATLAB starts in the MATLAB root folder and completes the initialization. After
starting, MATLAB changes to the Spreadsheet Link MATLAB startup folder. For details
about specifying the startup folder, see MLStartDir.

1-15
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Stop Spreadsheet Link and MATLAB

If you started the Spreadsheet Link and MATLAB software from the Excel interface:

* To stop both the Spreadsheet Link and MATLAB software, close the Excel session as
you normally would.

+ To stop the Spreadsheet Link and MATLAB software and leave the Excel session
running, enter the =MLClose() command into an Excel worksheet cell. You can use
the MLOpen or matlabinit function to restart the Spreadsheet Link and MATLAB
sessions manually.

If you connected an Excel session to an existing MATLAB session, close Excel and
MATLAB sessions separately. Closing one session does not automatically close the other.
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Work with MATLAB Functions in Microsoft Excel

In this section...
“Differences Between Spreadsheet Link and Microsoft Excel Functions” on page 1-17

“Spreadsheet Link Function Types” on page 1-17

“Use Spreadsheet Link Functions with Microsoft Excel” on page 1-18
“Use Worksheets” on page 1-21

“Work with Arguments” on page 1-22

“Use Spreadsheet Link Functions in Macros” on page 1-23

Differences Between Spreadsheet Link and Microsoft Excel Functions

* Spreadsheet Link functions perform an action, while Microsoft Excel functions return
a value.

*  Spreadsheet Link function names are not case-sensitive; that is, MLPutMatrix and
mlputmatrix are the same.

+ MATLAB function names and variable names are case-sensitive; that is, BONDS,
Bonds, and bonds are three different MATLAB variables.

Note: Excel operations and function keys might behave differently with Spreadsheet
Link functions.

Spreadsheet Link Function Types

Spreadsheet Link functions manage the connection and data exchange between the
Excel software and the MATLAB workspace, without your ever needing to leave the
Excel environment. You can run functions as worksheet cell formulas or in macros.
The Spreadsheet Link software enables Excel to act as an easy-to-use data-storage
and application-development front end for the MATLAB software, which is a powerful
computational and graphical processor.

There are two types of Spreadsheet Link functions: link management functions and data
management functions.

Link management functions initialize, start, and stop the Spreadsheet Link and
MATLAB software. You can run any link management function other than matlabinit

1-17
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as a worksheet cell formula or in macros. Run the matlabinit function from the Excel
Tools > Macro menu, or in macro subroutines.

Data management functions copy data between the Excel software and the MATLAB
workspace, and execute MATLAB commands in the Excel interface. You can run any
data management function other than MLPutVar and MLGetVar as a worksheet cell
formula or in macros. The MLPutVar and MLGetVar functions can run only in macros.

Use Spreadsheet Link Functions with Microsoft Excel

Execute a Function from the Microsoft Excel Ribbon

This example shows how to use the function mlputranges from the Microsoft Excel
Ribbon.

Start Microsoft Excel and start MATLAB.
2 Name and select a range in the worksheet.

3 Select Send named ranges to MATLAB using the MATLAB group that appears on
the top right of the Home tab in your Excel worksheet. When you select this option,
MATLAB executes mlputranges.

i i 4

ilter= Select-
1|l Start MATLAE

-

send data to MATLAE

Send named ranges to MATLAE
et data from MATLAR

Run MATLAE command

Get MATLAE figure

MATLAE Function Wizard

Preferences
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Microsoft Excel exports the named range into a MATLAB variable.
Execute a Function from a Microsoft Excel Cell

This example shows how to use the function mlputranges from a cell in the worksheet.

1  Start Microsoft Excel and start MATLAB.
2 Name and select a range in the worksheet.
3 Right-click a cell to list the MATLAB options.

1-19
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4 Select MATLAB > Send named ranges to MATLAB. When you select this option,
MATLAB executes mlputranges.

Microsoft Excel exports the named range into a MATLAB variable.

Use Worksheets

Enter Functions into Worksheet Cells

Spreadsheet Link functions expect Al-style worksheet cell references, that is, columns
designated with letters and rows with numbers (the default reference style). If your
worksheet shows columns designated with numbers instead of letters:

1 Select Tools > Options.

2 Click the General tab.

3 Under Settings, clear the R1C1 reference style check box.

Enter Spreadsheet Link functions directly into worksheet cells as worksheet formulas.

Begin worksheet formulas with + or = and enclose function arguments in parentheses.
The following example uses MLPutMatrix to put the data in cell C10 into matrix A:

=MLPutMatrix(""A", C10)

For more information on specifying arguments in Spreadsheet Link functions, see “Work
with Arguments” on page 1-22.

Caution: Do not use the Excel Function Wizard. It can generate unpredictable results.

After a Spreadsheet Link function successfully executes as a worksheet formula, the cell
contains the value 0. While the function executes, the cell might continue to show the
formula that you entered.

To change the active cell when an operation completes, select Excel Tools Options >
Edit > Move Selection after Enter. This action provides a useful confirmation for
lengthy operations.

Automatic Calculation Mode vs. Manual Calculation Mode

Spreadsheet Link functions are most effective in automatic calculation mode. To
automate the recalculation of a Spreadsheet Link function, add to it a cell whose value

1-21
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changes. In the following example, the MLPutMatrix function executes again when the
value in cell C1 changes:

=MLPutMatrix(''bonds"™, D1:G26) + C1

Caution: Be careful to avoid creating endless recalculation loops.

To use MLGetMatrix in manual calculation mode:

1 Enter the function into a cell.
2 Press F2.

3 Press Enter. The function executes.

Spreadsheet Link functions do not automatically adjust cell addresses. If you use explicit
cell addresses in a function, edit the function arguments to reference a new cell address
when you are:

+ Inserting or deleting rows or columns.

*  Moving or copying the function to another cell.

Note: Pressing F'9 to recalculate a worksheet affects only Excel functions. This key does
not operate on Spreadsheet Link functions.

Work with Arguments

This section describes tips for managing variable-name arguments and data-location
arguments in Spreadsheet Link functions.

Variable-Name Arguments

* You can directly or indirectly specify a variable-name argument in most Spreadsheet
Link functions:

To specify a variable name directly, enclose it in double quotation marks; for
example, MLDe leteMatrix(*'Bonds").

To specify a variable name as an indirect reference, enter it without quotation
marks. The function evaluates the contents of the argument to get the variable

1-22
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name. The argument must be a worksheet cell address or range name, for
example, MLDeleteMatrix(Cl).

Note: Spreadsheet Link functions do not support global variables. When exchanging
data between Excel and MATLAB, the base workspace is used. Variables in the base
workspace exist until you clear them or end your MATLAB session.

Data-Location Arguments

A data-location argument must be a worksheet cell address or range name.

Do not enclose a data-location argument in quotation marks (except in MLGetMatrix,
which has unique argument conventions).

A data-location argument can include a worksheet number; for example, Sheet3!
B1:C7 or Sheet2!OUTPUT.

Tip: You can reference special characters as part of a worksheet name in
MLGetMatrix or MLPutMatrix by embedding the worksheet name within single
quotation marks (" 7).

Use Spreadsheet Link Functions in Macros

About the Examples

These examples show how to manipulate MATLAB data using Spreadsheet Link.

For an example of how to exchange data between the MATLAB and Excel workspaces,
see “Import and Export Data Between Microsoft Excel and the MATLAB Workspace”
on page 1-25.

For an example of how to export data from the MATLAB workspace and display it
in an Excel worksheet, see “Send MATLAB Data to an Excel Worksheet” on page
1-23.

Send MATLAB Data to an Excel Worksheet

This example shows how to run MATLAB commands using VBA, send MATLAB data to
the Excel software, and display the results in an Excel dialog box.

1

Start an Excel session.
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Initialize the MATLAB session by clicking the startmatlab button in the
Spreadsheet Link toolbar or by running the matlabinit function.

Enable the Spreadsheet Link Add-In. For details, see “Configure Microsoft Excel” on
page 1-6.

Enable the Spreadsheet Link software as a Reference in the Microsoft Visual Basic
Editor. For instructions, see “Work with the Microsoft Visual Basic Editor” on page
1-10.

In the Visual Basic Editor, create a module.

a Right-click the Microsoft Excel Objects folder in the Project — VBAProject
browser.

b Select Insert > Module.

Enter the following code into the module window:

Option Base 1
Sub Methodl1()

MLShowMatlabErrors "yes"

"""To MATLAB:
Dim Vone(2, 2) As Double "Input

Vone(1, 1) =1
Vone(1, 2) = 2
Vone(2, 1) = 3
Vone(2, 2) = 4

MLPutMatrix "a', Range("'Al:B2')
MLPutVar ''b", Vone

MLEvalString (‘'c
MLEvalString (''d

= a*b")

= eig(c)™)

"*""From MATLAB:

Dim Vtwo As Variant "Output
MLGetVar *c*, Vtwo

MsgBox ''c is " & Vtwo(l, 1)

MLGetMatrix "b", Range(''A7:B8'").Address
MatlabRequest

MLGetMatrix "'c', "'Sheetl!A4:B5"
MatlabRequest

Sheets(*'Sheetl') .Select
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Range(*'A10") .Select
MLGetMatrix "'d", ActiveCell.Address
MatlabRequest

End Sub

Tip: Copy and paste this code into the Visual Basic Editor from the HTML version of
the documentation.

Run the code. Press F5 or select Run > Run Sub/UserForm.

The following dialog box appears.

-

Microsoft Excel @

cisl

8 Click OK to close the dialog box.

Note: Do not include MatlabRequest in a macro function unless the macro function is
called from a subroutine.

Tip: In macros, leave a space between the function name and the first argument. Do not
use parentheses.

Import and Export Data Between Microsoft Excel and the MATLAB Workspace

This example uses MLGetMatrix in a macro subroutine to export data from the
MATLAB matrix A into the Excel worksheet Sheetl.

Sub Testl()

MLGetMatrix "A", "SheetllIA5"
MatlabRequest
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End Sub

Note: The MatlabRequest function initializes internal Spreadsheet Link variables
and enables MLGetMatrix to function in the subroutine.

This example uses MLPutMatrix in a macro subroutine to import data into the
MATLAB matrix A, from a specified cell range in the Excel worksheet Sheetl.

Sub Test2()
Set myRange = Range(''A1:C3')
MLPutMatrix "A", myRange

End Sub

See Also

matlabfcn | matlabinit | matlabsub | MLGetMatrix | MLGetVar | MLPutMatrix
| MLPutRanges | MLPutVar | pathtool

Related Examples

“Configure Microsoft Excel” on page 1-6
“Work with the Microsoft Visual Basic Editor” on page 1-10
“Work with Dates” on page 1-36
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Work with the MATLAB Function Wizard

In this section...
“Work with MATLAB Functions” on page 1-28
“Work with Custom MATLAB Functions” on page 1-30

The MATLAB Function Wizard for the Spreadsheet Link software lets you browse
MATLAB folders and run functions from the Excel interface.

.

MATLAE Function Wizard ==

1. Select a category:

I matlab\elmat - Elementary matrices and matrix manipj Update |

2. Select a function:

ril “
frue —
vander ;I

3. Select a function signature;

TRIUCX)

TRIU(x,K)
friu

Function Help:

TRIL Extract upper triangular part.
TRIU(X) is the upper triangular part of X,
TRILUK K] is the elements on and above the K-th diagonal of
¥, K =0is the main diagonal, K = 0is above the main
diagonal and K < 0 is below the main diagonal.

See also TRIL, DIAG.

\_I*_ »
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Work with MATLAB Functions

1

List all MATLAB working folders and function categories.

All folders or categories in the current MATLABPATH appear in the Select a
category field. Click an entry in the list to select it. Each entry in the list appears
as a folder path and a description read from the Contents.m file in that folder. If no
Contents.mfile is found, the folder or category display notifies you as follows:

finance\finsupport -(No table of contents file)

To refresh the folder/category list, click Update.
Select a particular folder or category, and list functions available for that folder or

category.

After you select a folder or category, the Select a function field displays available
functions for that folder or category. Click a function name to select it.

Tip: The Function Wizard prohibits access to MATLAB constructors and methods.
You can write a wrapper function for a method or a constructor and access that
wrapper.

Select a function signature and enter a formula into the current worksheet cell.

After you select a function, the Select a function signature field displays available
signatures for that function. Click a function signature to select it.

View help information for the selected function.

The Function Help field displays help for the selected function.

When you click a function signature, the Function Arguments dialog box appears.
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i )

Function Arguments @
TRIU Inputs: e

X | -

Optional output cell(s): |

ad
TRIL Extract upper triangular part. i‘
=~

TRIU(X) is the upper triangular part of X,

TRIU{X,K) is the elements on and above the K-th diagonal of
¥, K =0is the main diagonal, K = 0 is above the main
diagonal and K < 0 is below the main diagonal.

oK. | iCancel

This dialog box lets you specify the cells that contain input arguments and the cells
where to display outputs. By default, the output of the selected function appears in the
current worksheet cell using the Spreadsheet Link function matlabfcn. In the following
example, the output appears in the current worksheet cell and generates a MATLAB
figure:

=matlabfcn('plot",Sheetl!1$B$2:$D$4)

Specifying a target range of cells using the Optional output cell(s) field causes the
selected function to appear in the current worksheet cell as an argument of matlabsub.
In addition, matlabsub includes an argument that indicates where to write the output.
In the following example, the data from A2 is input to the rand function, whose target
cell is B2:

=matlabsub("'rand”,""Sheetl1!$B$2",Sheetl1$A$2)

Tip Although the Function Wizard lets you specify multiple output cells, it does not
return multiple outputs. If you specify a range of output cells, the wizard returns the first
output argument starting in the first output cell.

For example, if a function returns two separate elements a and b, and you specify A1:A2
as output cells, the Function Wizard displays element a in cell Al. It discards element
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b. If an output is a matrix, the Function Wizard displays all elements of that matrix
starting in the first output cell.

Work with Custom MATLAB Functions

1

In MATLAB, create and save your function. Create a help header in your function
that contains supported function signatures to use with the MATLAB Function
Wizard. For example, write the function that computes the Fibonacci numbers and
save it in the folder Documents\MATLAB:

function ¥ = Fibonacci(n)
%FIBONACCI(N) Compute the Nth Fibonacci number.
% N must be a positive integer.

ifn<2O0
error("Invalid number.*)
elseif n == 0
f = 0;
elseif n ==
f=1;
else
f = fibonacci(n - 1) + Fibonacci(n - 2);
end;
end

Add the folder where you saved the function to the MATLAB search path. To add
the folder to the search path, use the pathtool function or select Set Path in the
MATLAB Toolstrip.

In Excel, open the MATLAB Function Wizard and select the folder where you saved
your function.
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MATLAB Function Wizard

=

1. Select a category:

I DocumentsMATLAE - (Mo table of contents file) j Update |

2. Select a function:
fibonacc

3. Select a function signature:

FIBOMACCI{N)
fibonacc

Function Help:

FIBOMACCI(M) Caompute the Mth Fibonacd number,
M must be a positive integer.

OK |

The Function Wizard does not let you access MATLAB constructors and methods. To
access a method or a constructor from the Function Wizard, write a wrapper function for
that method or constructor. For example, to access the timeseries(DATA) constructor
from the Function Wizard, write the following wrapper function:

function TS = timeseries_wrapper(DATA)
% timeseries_wrapper(DATA) is a wrapper function
% for TIMESERIES(DATA)
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% TS = TIMESERIES(DATA) creates a time series object TS using
% data DATA. By default, the time vector ranges from O to N-1,
% where N is the number of samples, and has an interval of 1
% second. The default name of the TS object is “unnamed”.

T = timeseries(DATA);

TS = T.data;

end
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Run a MATLAB Function with Multiple Output Arguments

This example shows how to execute a MATLAB function that returns multiple output
arguments in Microsoft Excel using a Microsoft Visual Basic macro. The macro writes
multiple output arguments from the MATLAB workspace to Microsoft Excel cells.

This example calculates the singular value decomposition of a matrix using svd.

1 In the Microsoft Excel cells from Al through C3, create a range of data. Enter
numbers from 1 through 3 in cells Al to A3. Enter numbers from 4 through 6 in cells
B1 to B3. Enter numbers from 7 through 9 in cells C1 to C3.

X - I 1
A B C D
1 1 2 3
2 4 5 b
3 7 8 9
[ |
4

2 Create a Microsoft Visual Basic macro named applysvd. For details about creating
macros, see Excel Help.

Public Sub applysvd()

MLOpen

MLPutMatrix "x", Range(''A1:C3")
MLEvalString ("[u,s,v] = svd(xX)"™)
MLGetMatrix *u™, "A5"
MLGetMatrix *'s', "A9"
MLGetMatrix "v', "A13"
MatlabRequest

MLClose

End Sub

The macro performs these tasks:

+  Starts MATLAB.

*  Sends the data in the A1 through C3 cell range to the MATLAB workspace and
assigns it to the MATLAB variable X.

*  Runs svd with the input argument X and output arguments u, s, and v.

1-33



1 Getting Started

+ Individually retrieves data for one output argument into a specific Microsoft
Excel cell while accounting for the size of each output data matrix to avoid
overwriting data. For the first output argument, retrieves the data for the output
argument U into cell A5.

* Closes MATLAB.

3 Run applysvd. MATLAB runs svd and populates the specified cells with data from
the three output arguments.

AS v j 2
A B C
1 1 2 3
2 4 5 6
3 7 8 9
4
5 | -D.2148.| 0.8872  0.4082
6 | -0.5206 0.2496 -0.8165
7 | -0.8263 -0.3879  0.4082
8
9 | 16.8481  0.0000  0.0000
10| 0.0000 1.0684  0.0000
11| 0.0000 0.0000 0.0000
12

13 -0.4737  -0.7767 0.4082
14 -0.5724 -0.0757  -0.8185
15 -0.6651 0.6253 0.4082
16

For details about running macros, see Excel Help.

See Also
MLClose | MLEvalString | MLGetMatrix | MLOpen | MLPutMatrix | svd
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Related Examples
. “Work with MATLAB Functions in Microsoft Excel” on page 1-17
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Work with Dates

1-36

Default Microsoft Excel date numbers represent the number of days that have passed
since January 1, 1900. For example, January 1, 1950 is represented as 18264 in the Excel
software.

However, MATLAB date numbers represent the number of days that have passed since
January 1, 0000, so January 1, 1950 is represented as 712224 in the MATLAB software.
Therefore, the difference in dates between the Excel software and the MATLAB software
1s a constant, 693960 (712224 minus 18264).

To use date numbers in MATLAB calculations, apply the 693960 constant as follows:

+ Add it to Excel date numbers that are read into the MATLAB software.
+  Subtract it from MATLAB date numbers that are read into the Excel software.

Note: If you use the optional Excel 1904 date system, the constant is 695422.

Dates are stored internally in the Excel software as numbers and are unaffected by
locale.

Related Examples
. “Work with MATLAB Functions in Microsoft Excel” on page 1-17
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Localization Information

This document uses Microsoft Excel with an English (United States) Microsoft
Windows regional setting for illustrative purposes. If you use Spreadsheet Link with a
non-English (United States) Windows desktop environment, certain syntactical
elements might not work as illustrated. For example, you might have to replace the
comma delimiter within Spreadsheet Link commands with a semicolon or other operator.

Please consult your Windows documentation to determine which regional setting
differences exist among non-U.S. versions.

Related Examples
. “Setting Spreadsheet Link Preferences” on page 1-11
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Solving Problems with the
Spreadsheet Link Software

* “Model Data Using Regression and Curve Fitting” on page 2-2

+  “Interpolate Data” on page 2-9

+ “Price Stock Options Using the Binomial Model” on page 2-13

+ “Compute Efficient Frontier of Financial Portfolios” on page 2-17

+ “Map Time and Bond Cash Flows” on page 2-22
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Model Data Using Regression and Curve Fitting

2-2

In this section...

“Using Worksheets” on page 2-2
“Using Macros” on page 2-6

Regression techniques and curve fitting attempt to find functions that describe the
relationship among variables. In effect, they attempt to build mathematical models of a
data set. MATLAB matrix operators and functions simplify this task.

This example shows both data regression and curve fitting. It also executes the same
example in a worksheet version and a macro version. The example uses Microsoft Excel
worksheets to organize and display the data. Spreadsheet Link functions copy the data
to the MATLAB workspace, and then executes MATLAB computational and graphic
functions. The macro version also returns output data to an Excel worksheet.

This example is included in the Spreadsheet Link product. To run it:

1 Start Excel, Spreadsheet Link, and MATLAB sessions.

2 Navigate to the folder matlabroot\toolbox\exlink\.
3 Open the file ExliSamp.xlIs

4 Execute the example as needed.

Using Worksheets

1  Click the Sheetl tab on the ExliSamp.xls window. The worksheet for this example
appears.
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1
2
3
4
5
6
7
8
9

10
1
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

A B C
Regression and Curve Fitting
DATA
35 207 1325
17 90 533
43 180 1013
4 187 1163
177 552 5326
57 354 2043
20 101 602
18 9 532
17 86 543
35 180 1134
25 136 766
17 84 495
23 102 635
24 148 913
40 292 1591
25 126 671
17 88 521
46 235 1319
v 204 1038
15 68 458
85 363 2904
66 300 2006
39 161 938
111 459 3282
16 g0 476

Spreadsheet Link Functions
1. Transfer the data to MATLAB.
#MATLAB' === MLPutMatrix("data", DATA)

2. Set up data for regression.

#MATLAB' <== MLEvalString("y = data(-,3)")
#MATLAB' <== MLEvalString("e = ones(length{data),1)")
#MATLAB' <== MLEvalString("A = [e data(,1:2)]")

3. Compute regression coefficients.
#MATLAB' <== MLEvalString("beta = Aly")

4. Calculate regressed result.
#MATLAB' <== MLEvalString("fit = A*beta")

5. Compare original data with regression results.
#MATLAB' === MLEvalString("[y.k] = sort(y}")
#MATLAB' === MLEvalString("fit = fit(k)")
#MATLAB' <== MLEvalString("n = size(data.1)")

6. Use MATLAB's polynomial solving functions for another curve fit.
EMATLAB' <== MLEvalString("[p.S] = polyfit(1:n.y".5)")
#MATLAB' <== MLEvalString("newfit = polyval(p.1:n.5)")

7. Plot curves and add legend
EMATLAB' <== MLEvalString("plot(1:n,y.’bo", 1:n.fit,'r", 1:n,newfit,'q’); legend(data’,fit', newfit’)")

The worksheet contains one named range: A4:C28 is named DATA and contains the
data set for this example.

Make E5 the active cell. Press F2; then press Enter to execute the Spreadsheet Link
function that copies the sample data set to the MATLAB workspace. The data set
contains 25 observations of three variables. There is a strong linear dependence
among the observations; in fact, they are close to being scalar multiples of each

other.

Move to cell E8 and press F2; then press Enter. Repeat with cells E9 and E10.
These Spreadsheet Link functions regress the third column of data on the other two
columns, and create the following:

+ A single vector y containing the third-column data.

* A three-column matrix A, that consists of a column of ones followed by the rest of
the data.
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Execute the function in cell E13. This function computes the regression coefficients
by using the MATLAB back slash (\) operation to solve the (overdetermined)
system of linear equations, A*beta = vy.

Execute the function in cell E16. MATLAB matrix-vector multiplication produces the
regressed result (Fit).

Execute the functions in cells E19, E20, and E21. These functions do the following:

a Compare the original data with Fit.
b Sort the data in increasing order and apply the same permutation to Fit.
¢ Create a scalar for the number of observations.

Execute the functions in cells E24 and E25. Often it is useful to fit a polynomial
equation to data. To do so, you would ordinarily have to set up a system of
simultaneous linear equations and solve for the coefficients. The MATLAB polyfit
function automates this procedure, in this case for a fifth-degree polynomial. The
polyval function then evaluates the resulting polynomial at each data point to
check the goodness of fit (newFit).

Execute the function in cell E28. The MATLAB plot function graphs the original
data (blue circles), the regressed result Fit (dashed red line), and the polynomial
result (solid green line). It also adds a legend.
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o

. Figurel EI@

File Edit View Inset Tools Desktop Window Help N

NEHde M| AROTDEL- 2|08 e

000 : | | |
O data
fit i)
o newfit |
4000 /
o)
3000 ] |
2000 -D / |
o
. Y
1000 . o o |
eR s mennptile e foo o
0 ) | | |
° 9 10 = - .

Since the data is closely correlated but not exactly linearly dependent, the Fit curve
(dashed line) shows a close, but not an exact, fit. The fifth-degree polynomial curve,
newFfit, is a more accurate mathematical model for the data.

When you finish this version of the example, close the figure window.
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Using Macros

1  Click the Sheet2 tab on ExliSamp.xIs. The worksheet for this example appears.

A B C D
Regression and Curve Fitting Macro
(See Module 1)
0 <== CurveFit(DATA "AT" "BT"."CT")

y fiit newfit

2 Make cell A4 the active cell, but do not execute it yet.
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Cell A4 calls the macro CurveFit, which you can examine in the Microsoft Visual
Basic environment.

E Microsoft Visual Basic for Applications - ExliSamp.xls

=N B =

! File Edit View Inset Format Debug Run Tools Add-Ins Window Help Type a question for help -
EE-d ¢ oo b0 @ BEFW S @ nzcon B
Project - ExliSamp x
5 x| & EdiSamp.xls - Modulel (Code) =R (5=
=l -5 (Ll

EE ExliSamp (ExliSamp.xls)
215§ Microsoft Excel Objects
Sheetl (Sheet1)
Sheet? (Sheet?)

Sheet3 (Sheet3) Function CurveFit(aData, sTargetl, sTargetZ, sTarget3)
Sheetd (Sheetd) '"MATLAE regression and curve fitting macro
Sheets (Sheets)
Sheets (Sheets) MLPutMatrix "data"™, aData
@ ThisWorkbook MLEvalString "v = datal(:,3)}"
-5 Modules MLEvalString "n = length(y}"
&Q Module 1 MLEvalString "e = ones(n,1}"
&[0 References MLEvalString "R = [e data(:,1l:2)]"
=% Spreadsheetlink2007_2010 MLEvalString "beta = A\y"
MILEvalString "fit = A*beta™
< | T b MLEvalString "[v,.k] = soxt(y)™
MLEvalString "fit = fic(k)"
Properties - Modulel x| MLEvalString "[p,S] = polyEfit(l:n,v',5)"
|Module1 Module - MLEvalString "newfit = polyval(p,l:n,5)'"
MLEvalString "plot(l:n,vy,'bo',l:n,fit,'r:',1:n,newfit, 'qg’'

Alphabetic ] Categorized ]

|:General]

j | (Declarations)

=

-

MLGetMatrix "y",

sTargetl

m Module 1

MLGetMatrix "fit",

sTarget

MLGetMatrix "newfit™,

sTarget3

End Function

3  While this module is open, make sure that the Spreadsheet Link Add-In is enabled.
To enable it, see “Add-In Setup” on page 1-6.

4 In cell A4 of Sheet2, press F2; then press Enter to execute the CurveFit macro.
The macro does the following:

a Runs the same functions as the worksheet example (in a slightly different
order), including plotting the graph.
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b Calls the MLGetMatrix function in the CurveF it macro. This macro copies to
the worksheet the original data y (sorted), the corresponding regressed data
fit, and the polynomial data newfit.

A B C D
Regression and Curve Fitting Macro
(See Module 1)

0 === CurveFit[DATA,"AT","BT"."CT")

y fiit newfit
1325 | 379.0475] 402.008
533 430.3099 | 515.8528
1013 | 462.4722 | 549.7114
1163 | 472.0222 | 543.0184
5326 | 501.7971] 524 5499
2043 | 4V6.7973] 513.775
602 467.2472 | 522.2081
532 570.8968 | 554.761
b43 641.1212 | 611.0947
1134 | 743.6461 | 686.9715
766 T67.5211| 775.6072
495 773.5589 ] 869.023
635 1143.761 | 959.3574
913 1279.593 | 1040.419
1591 | 1201.219] 1108.636
671 1098.695 | 1164.812
Yy 1251.081 | 1215276
1319 | 1476.743 | 1273.275
1038 | 1163.157 ] 1360.322
458 1479157 | 1507 557
2904 | 2086177 1757.08
2006 |2011.592] 2163.358
938 2666.224 | 2794 475
3282 | 3483.345] 3733.586
£y 476 5197.796 | 5080.215

(AN RS N R R R e L S T S R S g S T P = ) . T . T S g .
e R S R T I I I I S I I e el e U R R A e
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Interpolate Data

Interpolation is a process for estimating values that lie between known data points. It is
important for applications such as signal and image processing and data visualization.
MATLAB interpolation functions let you balance the smoothness of data fit with
execution speed and efficient memory use.

This example is included in the Spreadsheet Link product. To run it:

Start Excel, Spreadsheet Link, and MATLAB sessions.
Navigate to the folder matlabroot\toolbox\exlink\.
Open the file ExIiSamp.xls

AW N -

Execute the example as needed.

This example uses a two-dimensional data-gridding interpolation function on
thermodynamic data, where volume has been measured for time and temperature values.
It finds the volume values underlying the two-dimensional, time-temperature function
for a new set of time and temperature coordinates.

The example uses a Microsoft Excel worksheet to organize and display the original data
and the interpolated output data. You use Spreadsheet Link functions to copy the data
to and from the MATLAB workspace, and then execute the MATLAB interpolation
function. Finally, you invoke MATLAB graphics to display the interpolated data in a
three-dimensional color surface.

1  Click the Sheet3 tab on ExliSamp.xls. The worksheet for this example appears.
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A E C u] E F G H J K L I {1 ] P v} 5} S
1 |Data Interpolation
2
3 | DOriginal Data Interpolated Values
4 [Time |Temp | Volume
=) 0.025 6500 2504.05 Temp
B 0.050 6505 253507 Time 55.0 555 53.0 53.5 T0.0 705 7.0 k) 720 725 730 735 4.0 4.5
T 0.075 B5.07 256291 0.025)
g 0100 6803 2575.74 0.05
3 0125 658.20 Z606.16 0.075)
1o 0150 B850 262858 0.1
il 0175 6885 265138 0.125]
12 0.200 B3.22 2712.06 0.15)
13 0.225  T0.08 EVE7.52 0.175]
14 0.250 7033 2815.54 0.2
15 0.275 TO.53 2524.37 0.225)
1B 0.300  70.85 257365 0.25
17 0.325 T1IN E2S852.20 0.275)
1B 0.350 Tldd 253643 0.3
13 0.375 T8z 230207 0.325
20 0.400 T2.33 2520.04 0.35]
21 0425 V285 292335 0.375
22 0.450 T3.46 2334.23 0.4
23 0475 7385 293555 0.425
24 0500 V422 30293 0.45
25 0.525 T4.37 309312 0.475)
26 0.550 7455 3130.01 0.5
27 0575 T4ET7 317324 0.525
28 0.600 T4.72  3180.71 0.55§
23 0625 7500 315415 0.575
30 0.6

31 | Spreadsheet Link Functions

32 |1 Transfer ariginal data ta MATLAE.

33 | #MATLAE <== MLPuMatria("Labels”, Ad:Cd)
S | #MATLAE <== MLPutMatria"x" AS:A25)

35 | #MATLAE <== MLPutMatriz("T" B5:523)

36 | #MATLAE <== MLPutMatrix("\W",C5:C25)

5 | &, Transfer interpolation data points to MATLAB.
39 | #MATLAE <== MLPutMatris("xa" ET:E30)
A0 | #MATLAE <== MLPutMatria("Ta",FE: TE)

42 | 3. Execute MATLAE data interpolation function,
43 | #MATLAE <== MLEvalStringl T4l TI, VIl = griddatal, T\ ¥a,Ta, nearest]")

45 |4, Transpose output data matrix and transfer data ta Excel.
A6 | #MATLAE <== MLEwalString("IV = WI%")
47 | #MATLAE <== MLGetMatri["V","sheet IFT")

43 | 5. Plotinterpolated data and label the figure.
S0 | #MATLAE <== MLEwalString("surf(<]. TI, VIl tidelIrterpolated Data’); dlabel(L abels 1 wlabellL abels2}; zlabelLabels{3t ) grid on™)

The worksheet contains the measured thermodynamic data in cells A5:A29, B5:B29,
and C5:C29. The time and temperature values for interpolation are in cells E7 :E30
and F6:T6, respectively.

2 Make A33 the active cell. Press F2; then press Enter to execute the Spreadsheet
Link function that passes the Time, Temp, and Volume labels to the MATLAB
workspace.

3 Make A34 the active cell. Press F2; then press Enter to execute the Spreadsheet
Link function that copies the original time data to the MATLAB workspace. Move to
cell A35 and execute the function to copy the original temperature data. Execute the
function in cell A36 to copy the original volume data.
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Time

0.025)
0.05)
0.075)
0.1
0.125
0.15]
0.175
0.2
0.225)
0.25)
0.275)
0.3
0.325)
0.35)
0.5375)
0.4
0.425)
0.45)
0.475)
0.5
0.525)
0.55)
0.575)
0.6

4  Move to cell A39 and press F2; then press Enter to copy the interpolation time

values to the MATLAB workspace. Execute the function in cell A40 to copy the
interpolation temperature values.

5 Execute the function in cell A43. griddata is the MATLAB two-dimensional
interpolation function that generates the interpolated volume data using the inverse
distance method.

6 Execute the functions in cells A46 and A47 to transpose the interpolated volume data
and copy it to the Excel worksheet. The data fills cells F7:T30, which are enclosed in
a border.

Interpolated Yalues

Temp
535.0 53.5 53.0 53.5 70.0 0.5 71.0 71.5 7z.0 725 73.0 735 74.0 74.5 75.0

2504.05 263819 270732 275003 Z¥54.91 285113 29M62 234067 236140 238317 300006 3006832 304101 3512578 30Z6.85
250726 263576 2704.79 Z2V46.66 277396 284635 2307.00 233435 2355.07 257663 235364 233335 303443 3512643 3036.65
25910.83 263345 ZY02.58 274362 277040 2834184 230275 292964 2543.08 237051 238750 233260 302735 =697 304632
2513.93 263134 ZF00.70 274093 ZFTLET 283766 289585 2590466 254343 296466 255167 2386.08 302143 3F127.33 305577
2591514 2623.60 263307 2738 VT ZVET.E1 285383 283540 2320.07 233314 235314 237616 237383 301506 31LY.71 3065.02
251431 2628.58 2635.02 273633 2764.43 285035 2859231 2915.87 2333.23 239397 237033 237386 3005.70 312795 3074.05
25184 2628.88 263725 273066 ZTVEL.00 282731 288353 2208 2328.VZ 234307 236617 236821 300247 31281 303233
250810 262591 2636.87 273473 276022 282468 286726 290672 252462 234475 2361T1 236283 233633 512821 303157
250337 263132 269685 Z734.37 £759.24 282257 288523 230580 232036 2340.73 235765 235793 233050 3512825 3033.39
243784 263293 2659726 273442 275500 252105 288368 230334 231T.T6 233713 255397 255336 235486 512824 3108.19
243166 2634.64 2633.05 273491 279376 282023 288243 230133 231502 233397 235071 234320 237352 512818 51614
245492 2636.35 263516 273565 276112 252016 255155 283973 231278 233126 2594765 254545 237453 512807 3123.63
247771 26383.00 270064 Z27V3TEZ ZVE3.03 282081 288106 2838.72 Z9M04 2323.03 234547 254221 236336 790 313126
247007 2635.54 270241 2735.001 2765.53 282211 288097 283813 2309.82 252723 254352 233343 2365.89 3512766 313535
245206 2684033 270445 274113 27E8.54 282393 288123 Z2838.00 230313 232605 234201 235716 236233 3512730 314519
245370 264215 270675 274375 277163 262633 288203 283534 230897 252533 254096 =2335.42 235355 512673 315166
244503 264315 270526 274667 Z77S.62 252313 288320 283316 230834 232514 254037 233425 235745 S1Z6.07 315775
2436.07 264334  27N.87 274392 2¥TI6G 2032532 268475 230044 231023 2592548 254024 233367 255606 312503 316342
242682 264445 Z2714.84 275348 Z794.06 283583 288678 2302713 Z9ME3 292634 234057 2353371 235574 512385 316863
24173 264477 2TIT.O4 2TST.32 2TE8.T3 285976 286513 230440 251352 232771 234136 235434 255622 312246 317331
240754 ZB44.80 272095 Z7E1dd Z7VIIET 2544001 283133 2307.04 EI15.83 232557 234261 233555 235760 F1E1EV 317739
233751 264456 27-4.14 2TES.TI 2TISET 284855 283513 25101 231572 255190 2344.30 233730 235585 312085 3180.74
238724 264405 Z¥S7.E3 ZVTP03T 280431 2853.33 289877 23560 232133 295468 234643 233357 236283 312163 3183.21

237671 264325 2T30.67 2¥75.0d4 280397 285549 230271 231745 252567 2337.63 234893 234235 236666 312341 3184.53

7 Execute the function in cell A50. The MATLAB software plots and labels the
interpolated data on a three-dimensional color surface, with the color proportional to
the interpolated volume data.
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When you finish the example, close the figure window.
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Price Stock Options Using the Binomial Model

Price Stock Options Using the Binomial Model

The Financial Toolbox product provides functions that compute prices, sensitivities,
and profits for portfolios of options or other equity derivatives. This example uses the
binomial model to price an option. The binomial model assumes that the probability of
each possible price over time follows a binomial distribution. That is, prices can move
to only two values, one up or one down, over any short time period. Plotting these two
values over time is known as building a binomial tree.

This example organizes and displays input and output data using a Microsoft Excel
worksheet. Spreadsheet Link functions copy data to a MATLAB matrix, calculate the
prices, and return data to the worksheet.

This example is included in the Spreadsheet Link product. To run it:

Start Excel, Spreadsheet Link, and MATLAB sessions.
Navigate to the folder matlabroot\toolbox\exlink\.
Open the file ExliSamp.xls

AW N -

Execute the example as needed.

Note This example requires Financial Toolbox, Statistics and Machine Learning
Toolbox™, and Optimization Toolbox™.

1  Click the Sheet4 tab on ExliSamp.xIs to open the worksheet for this example.
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2 Solving Problems with the Spreadsheet Link Software

A B C D E F G H J K
1 |Binomial Option Pricing
2
3 bindata Spreadsheet Link Functions
4 |Asset price, so 5 52.00 1. Transfer data to MATLAB.
5 |Option exercise price, x | $ 50.00 #MATLAB' <== MLPutMatrix("b", bindata)
6 |RiskAree interest rate, r 10%
7 | Time to maturity, t {yrs) | 0.416667]=5/12 2. Execute MATLAB Financial Toolbox binomial option pricing function.
& |Time increment, dt 0.083333|=1/12 #MATLAB' <== MLEvalString("[p. o]=binprice(b(1). b{2). b(3), b4). b(5). b(E), b(7))"}
9 |Volatility, sig 0.4
10 |Call (1) or put (0), flag 0 3. Transfer output data to Excel.
11 #MATLAB <== MLGetMatrix("p", "asset_trea")
12 #MATLAB <== MLGetMatrix("o", "value_trea")
13
14 Start  Period 1 Period 2 Period 3 Period4  Period 5
15 | Asset price tree, p ($)
16
17
18
19
20
21
22
23 |Option value tree, o ($
24
25
26
27
28

The worksheet contains three named ranges:
* B4:B10 named bindata. Two cells in bindata contain formulas:

* BY7 contains =5/12

* B8 contains =1/12
* B15 named asset_tree.
* B23 named value_tree.

2 Make D5 the active cell. Press F2; then press Enter to execute the Spreadsheet Link
function that copies the asset data to the MATLAB workspace.

3 Move to D8 and execute the function that computes the binomial prices.

4 Execute the functions in D11 and D12 to copy the price data to the Excel worksheet.
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Price Stock Options Using the Binomial Model
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The worksheet looks as follows.

A B c D E F G H J K

Binomial Option Pricing
bindata Spreadsheet Link Functions

Asset price, so $ 52.00 1. Transfer data to MATLAB.
Option exercise price, x | $ 50.00 0 === MLPutMatrix("b", bindata)
Risk-free interest rate, r 10%
Time to maturity, t (yrs) | 0.416667]=5/12 2. Execute MATLAB Financial Toolbox binomial option pricing function.
Time increment, dt 0.083333]=1712 0 === MLEvalString("[p. o]=binprice(b(1}, b(2), b(3), b4), b(5), biG), b(7))")
Wolatility, sig 0.4
Call (1) or put {0), flag 0 3. Transfer output data to Excel.

0 === MLGetMatrix("p", "asset_tree”)
0 <== MLGetMatrix("0", "value_tree")

Start Period 1 Period 2 Period 3 Period4  Period 5

Asset price tree, p (§) £2.000 58365  B5.A09 73527 82527 92.628
0 46323 52000 58366  B5509 73527
0 0 41277 46329 52000 5B 365
0 0 0 36776 41277 46.329
0 0 0 0 32765 36776
0 0 0 0 0 23192
Option value tree, o ($ 3.728 1.664 0.428 0 0 0
0 5.918 2.964 0.876 0 0
0 0 9.060 5164 1.793 0
0 0 0 13.224 8.723 3.671
0 0 0 0 17.235 13.224
0 0 0 0 0  20.80§

Read the asset price tree as follows:

+ Period 1 shows the up and down prices.

* Period 2 shows the up-up, up-down, and down-down prices.

* Period 3 shows the up-up-up, up-up, down-down, and down-down-down prices.
* And so on.

Ignore the zeros. The option value tree gives the associated option value for each

node in the price tree. The option value is zero for prices significantly above the
exercise price. Ignore the zeros that correspond to a zero in the price tree.
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2 Solving Problems with the Spreadsheet Link Software

5 Try changing the data in B4:B10, and then executing the Spreadsheet Link
functions again.

Note: If you increase the time to maturity (B7) or change the time increment (B8),
you may need to enlarge the output tree areas.

6  When you finish the example, close the figure window.
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Compute Efficient Frontier of Financial Portfolios

MATLAB and Financial Toolbox functions compute and plot risks, variances, rates

of return, and the efficient frontier of portfolios. Efficient portfolios have the lowest
aggregate variance, or risk, for a given return. Microsoft Excel and the Spreadsheet Link
software let you set up data, execute financial functions and MATLAB graphics, and
display numeric results.

This example analyzes three portfolios, using rates of return for six time periods. In
actual practice, these functions can analyze many portfolios over many time periods,
limited only by the amount of computer memory available.

This example is included in the Spreadsheet Link product. To run it:

Start Excel, Spreadsheet Link, and MATLAB sessions.
Navigate to the folder matlabroot\toolbox\exlink\.
Open the file ExliSamp.xls

AW N -

Execute the example as needed.

Note This example requires Financial Toolbox, Statistics and Machine Learning Toolbox,
and Optimization Toolbox.

1  Click the Sheet5 tab on ExliSamp.xIs. The worksheet for this example appears.
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2 Solving Problems with the Spreadsheet Link Software

A B C D E F G H | J
1 |Portfolio Efficient Frontier
2 Global Corp.Bnd Small Cap
3 |Rates of return Global Corp. Bnd Small Cap Risk ROR Weights
4 Mov-91| 7.125% 4.125% B8.375%
5 Nov-92| 5.125% 5.125% 3.875%
] Mov-93| -1.375% 5.750% 10.500%
7 MNov-94| 7.750%  6.000% 14.750%
3 MNov-95| 8.250% 6.375% -3.625%
] MNov-96| 12.625% 6.125%  9.125%
10
11
12

13 | Spreadsheet Link Functions
14 |1. Transfer data to MATLAB.

5 | #MATLAB? === MLPutMatrix("Labels", F3:G3)
16 |#MATLAB? === MLPutMatrix{"retseries”, B4:09)
17
18 |2. Execute MATLAB Financial Toolbox functions.
19 | #MATLAB? === MLEvalString("[ret, cov] = ewstats(retseries)”)
20 |#MATLAB? === MLEvalString(“[risk, ror, weights] = portoptiret, cov, 2007
21
22 |3. Transfer output data to Excel.
23 #MATLAB? === MLGetMatrix(risk”, "sheet5lF4™)
24 | #MATLAB? === MLGetMatrix("ror”, "sheets!G4")
25 |#MATLAB? === MLGetMatrix{"weights”, "sheet5IH4")
26
27 |4. Plot efficient frontier data and label the figure.
28 [ #MATLAB? === MLEvalString("portopt(ret, cov, 20); grid on; xlabel(Labels{1}); ylabel(Labels{2})")

2 Make A15 the active cell. Press F2; then press Enter. The Spreadsheet Link
function transfers the labels that describe the output that the MATLAB software
computes.

3 Make A16 the active cell to copy the portfolio return data to the MATLAB
workspace.

4 Execute the functions in A19 and A20 to compute the Financial Toolbox efficient
frontier function for 20 points along the frontier.

5 Execute the Spreadsheet Link functions in A23, A24, and A25 to copy the output
data to the Excel worksheet.

The worksheet looks as follows.
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A B C D E F G H | J
1 | Portfolio Efficient Frontier
2 Global Corp. Bnd Small Cap
3 |Rates of return Global Corp. BndSmall Cap Risk ROR Weights
4 Nov-91| 7.125% 4.125% 8.375% 0.730%| 5.643% 0.3% 96.1% 3.5%
5 Nov-92| 5.125% 5.125%  3.875% 0.760%| 5.723% 4.0% 89.7% 6.3%
6 MNov-93| -1.375%  5750%  10.500% 0.844%| 5.803% 7.7% 83.3% 9.0%
7 Nov-94| 7.750% 6.000% 14.750% 0.968%| 5.883% 11.3% 76.9% 11.8%
8 Nov-95| 8.250% 6.375% -3.625% 1.118%| 5.964% 15.0% 70.5% 14.5%
9 Nov-96) 12.625% 6.125%  9.125% 1.287%| 6.044% 18.7% 64.0% 17.3%
10 1.466%)] 6.124% 22.3% 57.6% 20.0%
11 1.653%| 6.204% 26.0% 51.2% 22.8%
12 1.846%| 6.284% 29.7% 44.8% 25.5%
13 | Spreadsheet Link Functions 2.042%| 6.365% 33.3% 38.4% 28.3%
14 |1. Transfer data to MATLAB. 2241%| 6.445% 37.0% 32.0% 31.1%
15 0 === MLPutMatrix("Labels", F3:G3) 2.443%| 6.525% 40.6% 25.6% 33.8%
16 0 === MLPutMatrix(retseries”, B4:09) 2 B46%| 6.605% 44.3% 19.1% 36.6%
17 2.850%| 6.685% 438.0% 12.7% 39.3%
18 |2. Execute MATLAB Financial Toolbox functions. 3.055%] B.766% 51.6% 6.3% 42 1%
19 0 === MLEval3tring("[ret, cov] = ewstats(retseries)”) 3.262%| 6G.846% 55.0% 0.0% 45.0%
20 0 === MLEvalString(“[risk, ror, weights] = portopt(ret, cov, 20)7) 3.620%| 6.926% 41.3% 0.0% 58.7%
21 4.213%| 7.006% 27.5% 0.0% 72.5%
22 |3, Transfer output data to Excel. 4.955%| 7.086% 13.8% 0.0% 86.2%
23 0 === MLGetMatrix("risk”, "sheet5IF4) 5791%| 7.167% 0.0% 0.0% 100.0%
24 0 === MLGetMatrix("ror”, "sheetalG4")
25 0 === MLGetMatrix["weights”, "sheetsIH4")
26
27 4. Plot efficient frontier data and label the figure.
28 |#MATLAB? === MLEvalString("portopt(ret, cov, 20); grid on; xlabel(Labels{1}); ylabel(Labels{2})")

The data describes the efficient frontier for these three portfolios: that set of points

representing the highest rate of return (ROR) for a given risk. For each of the 20
points along the frontier, the weighted investment in each portfolio (Weights) would

achieve that rate of return.

6 Now move to A28 and press F2; then press Enter to execute the Financial Toolbox

function that plots the efficient frontier for the same portfolio data.

The following figure appears.
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2 Solving Problems with the Spreadsheet Link Software
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The light blue line shows the efficient frontier. Note the change in slope above a 6.8%
return because the Corporate Bond portfolio no longer contributes to the efficient
frontier.

7 To try running this example using different data, close the figure window and change
the data in cells B4:D9. Then execute all the Spreadsheet Link functions again. The
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Compute Efficient Frontier of Financial Portfolios

worksheet then shows the new frontier data, and the MATLAB software displays a
new efficient frontier graph.

When you finish this example, close the figure window.
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2 Solving Problems with the Spreadsheet Link Software

Map Time and Bond Cash Flows

This example shows how to use the Financial Toolbox and Spreadsheet Link software to
compute a set of cash flow amounts and dates, given a portfolio of five bonds with known
maturity dates and coupon rates. It is included in the Spreadsheet Link product. To run

it:

1 Start Excel, Spreadsheet Link, and MATLAB sessions.

2 Navigate to the folder matlabroot\toolbox\exlink\.
3 Open the file ExliSamp.xls

4 Execute the example as needed.

Note This example requires Financial Toolbox, Statistics and Machine Learning Toolbox,
and Optimization Toolbox.

1  Click the Sheet6 tab on ExliSamp.xIs. The worksheet for this example appears.
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Map Time and Bond Cash Flows

A B c D E F G H [ J K L M N
1 |Cash Flow and Time Mapping for a Portfolio of Bonds
2 Cash Flow Dates
3 |Settlement Date 26-Jul-99 Bond1
4 Bond2
5 Bond Data Bond3
6 Bond4
7 Maturity Coupon Rate Bond5
& Bond1 15-Mov-99 0.05875
9 Bond2 15-May-00 0.06375
10 | Bond3 15-Mov-00 0.08500
11 Bond4 15-May-01 0.08000
12 | Bond3 16-Mov-01 0.15750 Cash Flow Amounts
13
14 Bond1
15 Bond2
16 | Spreadsheet Link Functions Bond3
17 |1. Transfer data to MATLAB. Bond4
18 #MATLAB" <== MLPutMatrix({"maturity”, Maturity’) Bond3

19 |#MATLAB’ <== MLPutMatrix("cpnrate”,"CpnRate")
20 |#MATLAB’ == MLPutMatrix("sd",C3)

22 |2. Execute MATLAB Financial Toolbox Cash flow and Time mapping function.
23 |#MATLAB’ === MLEvalString("md = x2mdate(maturity,0); sdm = x2mdate(sd,0)")
24 [ #MATLAB’ <== MLEvalString("[cfa, cfd] = cfamounts(cpnrate, sdm, md, 2)")

26 3. Transform date numbers to cell array of character vectors.

27 |#MATLAEI'<== MLEvalString("i = find(isnan(cfd)); zcfd = cfd; zcfd(i) = 0; scfd=datestr(zcfd,2);")

28 | #MATLAB’ === MLEvalstring("ccfd = num2cell{scfd.2); ccfd(i) = {N/AY; ccfd = reshape(ccfd, size(cfd)).")
29 #MATLAB' <== MLEvalString("ccfa = cfa; ccfa(i) = 0; alldates = ccfd(end, :);")

30

31 4. Transfer output data to Excel.

32 |EMATLAB’ <== MLGetMatrix("ccfd", "sheet6li3")

33 [BMATLAB’ <== MLGetMatrix("alldates", "sheetfli13")

34 |#MATLAB == MLGetMatrix("ccfa”, "sheetfli14")

35

36 |5. Plat the cash flow diagram.

37 |#MATLAB’ === MLEvalString("cfplot(cfd, cfa); dtaxis(x’6,sdm,50);title(Cash Flow Diagram’);xlabel(Cash Flow Dates’);ylabel(Bonds’);")

2 Make A18 the active cell. Press F2, then Enter to execute the Spreadsheet Link
function that transfers the column vector Maturity to the MATLAB workspace.

3 Make A19 the active cell to transfer the column vector Coupon Rate to the
MATLAB workspace.

4 Make A20 the active cell to transfer the settlement date to the MATLAB workspace.

5 Execute the functions in cells A23 and A24 to enable the Financial Toolbox software
to compute cash flow amounts and dates.

6 Now execute the functions in cells A27 through A29 to transform the dates into a cell
array of character vectors.
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7 Execute the functions in cells A32 through A34 to transfer the data to the Excel

worksheet.

A B c D E F G H J
Cash Flow and Time Mapping for a Portfolio of Bonds

K L M N

Cash Flow Dates

Settlement Date 26-Jul-99 Bond1 |7/26/1999 11/16/1999
Bond2 |7/26/1999 11/15/1999

Bond Data Bond3 |7/26/1999 11/15/1999

Bondd | 7/26/1999 11/15/1999

Maturity Coupon Rate Bond3 | 7/26/1999 11/15/1999

/A, N/A /A /A
5/15/2000 N/A N/A NIA
5/15/2000 11/15/2000  M/A NIA
5/15/2000 11/15/2000 5/15/2001 NIA

5/M15/2000 11/15/2000 515/2001 11/15/2001

Bond1 15-MNov-99 0.05875
Bond2 15-May-00 0.06375
Bond3 15-Nov-00 0.08500
Bond4 15-May-01 0.08000
Bond5 15-MNov-01 0.15750

Cash Flow Amounts

5/15/2000 11/15/2000 515/2001 11/15/2001

0 0 0 0
103.1875 0 0 0
4.2500  104.2500 0 0

4.0000 4.0000  104.0000 0
7.8750 7.8750 7.8750  107.8750

7/26/1999 11/15/1999
Bond1 -1.1495 | 102.9375
Bond2 -1.2473 3.1875
Spreadsheet Link Functions Bond3 -1.6630 4.2500
1. Transfer data to MATLAB. Bond4 -1.5652 4.0000
0 === MLPutMatrix("maturity”, Maturity’) Bond5 -3.0815 7.8750
0 === MLPutMatrix("cpnrate”,"CpnRate")
0 === MLPutMatrix("sd",C3)
2. Execute MATLAB Financial Toolbox Cash flow and Time mapping function.

0 «== MLEvalString("md = x2mdate(maturity,0); sdm = x2mdate(sd.0)")
0 === MLEvalString("[cfa, cfd] = cfamounts(cpnrate, sdm, md, 2)")

3. Transform date numbers to cell array of character vectors.
0 === MLEvalString("i = find{isnan{cfd)); zcfd = cfd; zcfd(i) = 0; scfd=datestrizcfd,2);")
0 === MLEvalstring("ccfd = num2cell(scfd,2); ccfd(i) = {N/AT; ccfd = reshape(cefd, size(cfd)).")
0 === MLEvalString("ccfa = cfa; ccfa(i) = 0; alldates = ccfd(end, :);")

4. Transfer output data to Excel.
0 «== MLGetMatrix("ccfd", "sheet6li3")
0 === MLGetMatrix("alldates", "sheetbli13")
0 === MLGetMatrix("ccfa”, "sheetbli14")

5_Plot the cash flow diagram.

0 === MLEvalString("cfplot(cfd, cfa); dtaxis(x',6.sdm.50):title(Cash Flow Diagram’);xlabel(Cash Flow Dates'):ylabel(Bonds’);")

8 Finally, execute the function in cell A37 to display a plot of the cash flows for each

portfolio item.




Map Time and Bond Cash Flows

< Figurel oo
File Edit View Inset Tools Desktop Window Help N
ﬂjlﬂq&! [:34-\_\@@@%'@;']@ DE
Cash Flow Diagram
11!‘
21!
%
=
5
o3[
4
ik
R S S
L 4
0726 11115 05/15 11/15 05/15 11115
Cash Flow Dates

9 When you finish the example, close the figure window.
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+ “Worksheet Cell Errors” on page 3-2
+ “Microsoft Excel Errors” on page 3-5
* “Data Errors” on page 3-8

* “License Errors” on page 3-10

+  “Startup Errors” on page 3-11

+  “Audible Error Signals” on page 3-13



3 Error Messages and Troubleshooting

Worksheet Cell Errors

You might see these error messages displayed in a worksheet cell.

The first column contains worksheet cell error messages. The error messages begin with
the number sign (#). Most end with an exclamation point (1) or with a question mark (?).

Worksheet Cell Error Messages

Error Message

Meaning

Solution

3-2

The excllink.xla add-in is not

#COLS>#MAXCOLS! Your MATLAB variable exceeds the | This is a limitation in the Excel
Microsoft Excel limit of #MAXCOLS! |product. Try the computation
columns. with a variable containing fewer

columns.

#COMMAND! The MATLAB software does not Verify the spelling of the MATLAB
recognize the command in an command. Correct typing errors.
MLEvalString function. The
command might be misspelled.

#DIMENSION! You used MLAppendMatrix and Verify the matrix dimensions and
the dimensions of the appended the appended data dimensions,
data do not match the dimensions |and correct the argument.
of the matrix you want to append. |For more information, see the

MLAppendMatrix reference page.

#INVAL 1DNAME! You entered an illegal variable Make sure to use legal MATLAB

name. variable names. MATLAB variable
names must start with a letter
followed by up to 30 letters, digits,
or underscores.

#INVALIDTYPE! You specified an illegal MATLAB |Make sure to use the supported
data type with MLGetVar or MATLAB data types.
MLGetMatrix.

#MATLAB? You used a Spreadsheet Link Start the Spreadsheet Link and
function and no MATLAB software | MATLAB software. See “Start
session is running. and Stop Spreadsheet Link and

MATLAB” on page 1-14.

#NAME? The function name is unrecognized. | Be sure the excllink.xla add-

in is loaded. See “Add-In Setup”
on page 1-6. Check the spelling of




Worksheet Cell Errors

Error Message

Meaning

Solution

loaded, or the function name might
be misspelled.

the function name. Correct typing
errors.

#NONEXIST! You referenced a nonexistent Verify the spelling of the MATLAB
matrix in an MLGetMatrix or matrix. Use the MATLAB whos
MLDeleteMatrix function. The command to display existing
matrix name might be misspelled. |matrices. Correct typing errors.
Also, you receive the #NONEX1ST!
error when you attempt to use
matlabfcn to obtain an output.

#ROWS>HMAXROWS!! Your MATLAB variable exceeds the|This is a limitation in the Excel
Excel limit of #MAXROWS! rows. product. Try the computation with

a variable containing fewer rows.

#SYNTAX? You entered a Spreadsheet Link Verify and correct the function
function with incorrect syntax. syntax.
For example, you did not specify
double quotation marks (*"), or you
specified single quotation marks (')
instead of double quotation marks.

#VALUE! An argument is missing from a Supply the correct number of
function, or a function argument is |function arguments, of the correct
the wrong type. type.

#VALUE! A macro subroutine uses Since the function works
MLGetMatrix followed by correctly, ignore the message.
MatlabRequest, which is correct |Or, in this special case, remove
standard usage. A macro function |(MatlabRequest from the
calls that subroutine, and you subroutine.
execute that function from a
worksheet cell. The function works
correctly, but this message appears
in the cell.

#INVALI1DRANGE! The named range is defined Select a range of data on only

incorrectly, or the named range
spans multiple worksheets.

one worksheet and create an
appropriate name for the range
of data. For instructions about
defining names, see Excel Help.
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3-4

Note: When you open an Excel worksheet that contains Spreadsheet Link functions, the
Excel software tries to execute the functions from the bottom up and right to left. Excel
might generate cell error messages such as #COMMAND! or #NONEXIST!. This is expected
behavior, so ignore the messages and do the following:

1  Close the MATLAB figure windows.

2 Execute the cell functions again one at a time in the correct order by pressing F2,
and then Enter.




Microsoft Excel Errors

Microsoft Excel Errors

The Excel software can display these error messages.

Error Message

Cause of Error

Solution

Error in formula

You entered a formula
incorrectly. Common errors
include a space between
the function name and the
left parenthesis; or missing,
extra, or mismatched
parentheses.

Note: If you use the
Spreadsheet Link software
with a non-English (United
States) Windows desktop
environment, certain
syntactical elements might
not work. For details, see
“Localization Information”
on page 1-37.

Review the entry and correct
typing errors.

Can"t find project or
library

or

Compile error: Sub or
Function not defined

You executed a macro

and the location of
excllink.xlais incorrect
or not specified.

Click OK. The References
window opens. Remove the
check mark from MISSING:
excllink.xla. Find
excllink.xlain its correct
location, select its check box
in the References window,
and click OK. Or, select
Tools > References to open
the References window.
Select the box named
SpreadsheetLink2007_2010.
Click OK.

Run-time error
"1004": Cells method

You used MLGetMatrix
and the matrix is larger

Click OK. Reset worksheet

calculation mode to
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Error Message

Cause of Error

Solution

of Application class
failed

than the space available in
the worksheet. This error
destabilizes the Spreadsheet
Link software session

and changes worksheet
calculation mode to manual.

automatic, and save your
worksheet as needed. Restart
the Excel, Spreadsheet Link,
and MATLAB software
sessions.

MATLAB failed to
check out a license
of Spreadsheet Link
or does not have a
valid installation of
Spreadsheet Link

You entered an invalid
license passcode or did not
install Spreadsheet Link
properly.

Ensure that you entered
the license passcode
properly. Reinstall the
Spreadsheet Link add-on.
(See “Installation” on page
1-4.) If you followed the
installation guidelines, used
a proper passcode, and you
are still unable to start the
Spreadsheet Link software,

contact your MathWorks®
representative.

Datasource: Excel;
prompt for user name
and password

This message appears when
an attempt to connect to
the Excel software from

the Database Toolbox™
software fails.

Ensure that the Excel
worksheet referenced by the
data source exists, then retry
the connection.

Could not load some
objects because they
are not available on
this machine

This message appears when
Excel 2013 is not configured
properly.

From the Windows Control
Panel, remove Microsoft
Office 2010 in the programs
list.




Microsoft Excel Errors

Error Message

Cause of Error

Solution

Microsoft Visual Basic

Run-time error ‘429"

ActiveX component can't create object

End

Help

This error appears when
you start the automation
server from the Excel
interface, and multiple
versions of the MATLAB
software are installed on
your desktop.

To correct this error, perform
the following:

1

2

Shut down all MATLAB
and Excel instances.

Open a command
prompt, and using

cd, change to the bin
\win64 subfolder of the
MATLAB installation
folder.

Type the command:

-\matlab /regserver

When the MATLAB
session starts, close it.
Using /regserver fixes
the registry entries.

Start an Excel session.
The Spreadsheet Link
add-in now loads
properly.

Verify that the
Spreadsheet Link
software 1s working by
entering the following
command from the
Command Window:

a = 3.14159

Enter the following
formula in cell Al of the
open Excel worksheet:

=mlgetmatrix("a","al")

The value 3.14159
appears in cell Al.
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Data Errors

In this section...

“Matrix Data Errors” on page 3-8
“Errors When Opening Saved Worksheets” on page 3-8

Matrix Data Errors

Data in the MATLAB or Microsoft Excel workspaces may produce the following errors.

Data Errors

Data Error Cause Solution
MATLAB matrix cells Corresponding Excel worksheet Excel worksheet cells must
contain zeros (0). cells are empty. contain only numeric or string
data.
MATLAB matrix is a 1- You used quotation marks Correct the syntax to remove
by-1 zero matrix. around the data-location quotation marks.
argument in MLPutMatrix or
MLAppendMatrix.
MATLAB matrix is empty |You referenced a nonexistent VBA |Correct the macro; you may
an. variable in MLPutVar. have typed the variable name
incorrectly.
VBA matrix is empty. You referenced a nonexistent Correct the macro; you may

MATLAB variable in MLGetVar. |have typed the variable name
incorrectly.

Errors When Opening Saved Worksheets

This section describes errors that you may encounter when opening saved worksheets.

3-8

When you open an Excel worksheet that contains Spreadsheet Link functions, the
Excel software tries to execute the functions from the bottom up and right to left.
Excel may generate cell error messages such as #COMMAND! or #NONEXIST!. This is
expected behavior. Do the following:

1 Ignore the messages.




Data Errors

2
3

Close MATLAB figure windows.

Execute the cell functions again one at a time in the correct order by pressing F2,
and then Enter.

If you save an Excel worksheet containing Spreadsheet Link functions, and then
reopen it in an environment where the excllink.xla add-in is in a different
location, you may see the message: This document contains links: Re-
establish links?

To address this issue, do the following:

AW N —-

Click No.
Select Edit > Links.
In the Links dialog box, click Change Source.

In the Change Links dialog box, select matlabroot\toolbox\exlink
\excllink.xla.

Click OK.

The Excel software executes each function as it changes its link. You may see
MATLAB figure windows and hear error beeps as the links change and functions
execute; ignore them.

In the Links dialog box, click OK.

The worksheet now connects to the Spreadsheet Link add-in.

Or, instead of using the Links menu, you can manually edit the link location in each
affected worksheet cell to show the correct location of excllink.xla.
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License Errors

If you are running an automation server of MATLAB that does not have a Spreadsheet
Link license associated with it, you will receive an license error message. To correct this
issue, from the MATLAB installation that includes Spreadsheet Link, run the command:

matlab /regserver
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Startup Errors

In this section...
“Starting MATLAB Automatically” on page 3-11
“Setting the MATLAB Version” on page 3-11

Starting MATLAB Automatically

If you have enabled MLAutoStart, double-clicking an .x1Is file in the MATLAB Current
Folder browser and choosing Open Outside MATLAB causes a Microsoft Excel error to
appear. To open the file successfully, click End in the error window.

To avoid this issue, disable MLAutoStart. Start MATLAB sessions from Microsoft Excel
by selecting Start MATLAB in the MATLAB group.

Setting the MATLAB Version

Set the MATLAB version using MLProgramld. If the MATLAB version is set incorrectly,
MATLAB does not start and displays this error: Unable to start MATLAB. Please
register MATLAB Software as a COM Server.

Ensure that the correct MATLAB version appears in the Preferences dialog box before
starting MATLAB. For details, see “Setting Spreadsheet Link Preferences” on page 1-11.

If MATLAB is installed on your computer and setting the MATLAB version does not
work, use the last registered version to start MATLAB. To specify the last registered
version of MATLAB:

1 Shut down all MATLAB and Excel sessions.

2 Open a Command Prompt window, and using cd, change to the bin\win64
subfolder of the MATLAB installation folder.

3 Enter the command:

-\matlab /regserver

See Also
MLAutoStart | MLProgramid
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3 Error Messages and Troubleshooting

More About

“Installation” on page 1-4

“Add-In Setup” on page 1-6

“Setting Spreadsheet Link Preferences” on page 1-11
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Audible Error Signals

Audible Error Signals

You may hear audible errors while passing data to the MATLAB workspace using
MLPutMatrix or MLAppendMatr ix. These errors usually indicate that you have
insufficient computer memory to carry out the operation. Close other applications or
clear unnecessary variables from the MATLAB workspace and try again. If the error

signal reoccurs, you probably have insufficient physical memory in your computer for this
operation.
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matlabfcn

Evaluate MATLAB command given Microsoft Excel data

Syntax

matlabfcn(command, inputs)

Description

matlabfcn(command, inputs) passes the command to the MATLAB workspace for
evaluation, given the function input data. The function returns a single value or string
depending upon the MATLAB output. The result is returned to the calling worksheet
cell. This function is intended for use as an Excel worksheet function.

Input Arguments

command

MATLAB command to evaluate.

Embed the command in double quotes, for example, ""command"".
inputs

Variable length input argument list passed to a MATLAB command.

The argument list may contain a range of worksheet cells that contain input data.

Examples

Compute the Sum of Excel Data and Return the Result to an Active Cell

Add the data in worksheet cells B1 through B10 returning the sum to the active
worksheet cell:
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matlabfen

matlabfcn(*'sum', B1:B10)
Plot Excel Data Using the MATLAB Plotting Function

Plot the data in worksheet cells B1 through B10, using X as the marker type:
matlabfcn(plot™, B1:B10, "x')

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

More About
Tips

+ If matlabfcn fails, then by default you get a standard Spreadsheet Link error, such
as #COMMAND. To return MATLAB errors, use MLShowMatlabErrors.

See Also

matlabsub | MLShowMatlabErrors

Introduced before R2006a
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matlabinit

Initialize Spreadsheet Link and start MATLAB

Syntax

matlabinit

Description

matlabinit Initializes the Spreadsheet Link software and starts MATLAB process.

If the Spreadsheet Link software has been initialized and the MATLAB software is
running, subsequent invocations do nothing. Use matlabinit to start Spreadsheet
Link and MATLAB sessions manually when you have set MLAutoStart to no. If you set
MLAutoStart to yes, matlabinit executes automatically.

More About
Tips

+ To run matlabinit from the Microsoft Excel toolbar, click Tools > Macro. In the
Macro Name/Reference box, enter matlabinit and click Run. Alternatively, you
can include this function in a macro subroutine. You cannot run matlabinitasa
worksheet cell formula or in a macro function.

See Also
MLAutoStart | MLOpen

Related Examples
. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

Introduced before R2006a
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matlabsub

Evaluate MATLAB command given Microsoft Excel data and designate output location

Syntax

matlabsub(command, edat, inputs)

Description

matlabsub(command, edat, inputs) passes the specified command to the MATLAB
workspace for evaluation, given the function input data. The function returns a single
value or string depending upon the MATLAB output. This function is intended for use as
an Excel worksheet function.

Input Arguments

command

MATLAB command to evaluate.

Enter the MATLAB command in double quotes, for example, "*command®".
edat

Worksheet location where the function writes the returned data.

edat in quotes directly specifies the location.edat without quotes specifies a worksheet
cell address (or range name) that contains a reference to the location. In both cases, edat
must be a cell address or a range name.

Although you can specify a range of output cells, matlabsub does not support multiple
outputs. Instead of returning multiple outputs, matlabsub returns the first output
starting in the first cell from the specified range, and discards all other outputs.

inputs

Variable length input argument list passed to MATLAB command.
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This argument list can contain a range of worksheet cells that contain input data.

Examples

Compute the Sum of Data and Return Result to the Specified Cell

Sum the data in worksheet cells B1 through B10 returning the output to cell Al:

matlabsub(**sum*, "Al", B1:B10)

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

More About
Tips
* To return an array of data to the Microsoft Excel Visual Basic for Applications (VBA)

workspace, see MLEvalString and MLGetVar.

+ edat must not include the cell that contains the matlabsub function. In other words,
be careful not to overwrite the function itself.

* Ensure that there is enough room in the worksheet to write the matrix contents. If
there is insufficient room, the function generates a fatal error.

+ If matlabsub fails, then by default you get a standard Spreadsheet Link error, such
as #COMMAND. To return MATLAB errors, use MLShowMatlabErrors.

See Also

matlabfcn | MLShowMatlabErrors

Introduced before R2006a
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MLAppendMatrix

Create or append MATLAB matrix with data from Microsoft Excel worksheet

Syntax

MLAppendMatrix(var_name,mdat)
MLAppendMatrix var_name,mdat
out = MLAppendMatrix(var_name,mdat)

Description

MLAppendMatrix(var_name,mdat) appends data in mdat to MATLAB matrix
var_name or creates var_name if it does not exist. Use this syntax when working directly
in a worksheet.

MLAppendMatrix var_name,mdat appends data in mdat to MATLAB matrix
var_name or creates var_name if it does not exist. Use this syntax in a VBA macro.

out = MLAppendMatrix(var_name,mdat) lets you catch errors when executing
MLAppendMatrix in a VBA macro. If MLAppendMatrix fails, then out is a string
containing error code. Otherwise, out is O.

Input Arguments
var_name
Name of MATLAB matrix to which to append data.

var_name in quotes directly specifies the matrix name. var_name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name. Do not
use the MATLAB variable ans as var_name.

mdat

Location of data to append to var_name.
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mdat must be a worksheet cell address or range name. Do not enclose it in quotes.

mdat must contain either numeric data or string data. Data types cannot be combined
within the range specified in mdat. Empty mdat cells become MATLAB matrix elements
containing zero if the data is numeric, and empty character vectors if the data is a string.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Append Data from a Worksheet Cell Range to a MATLAB Matrix

In this example, B is a 2-by-2 MATLAB matrix. Append the data in worksheet cell range
Al:A2 to B:

MLAppendMatrix("'B", Al:A2)

Al
A2

B is now a 2-by-3 matrix with the data from A1:A2 in the third column.
Append Data from a Named Worksheet Cell Range to a MATLAB Matrix

B is a 2-by-2 MATLAB matrix. Cell C1 contains the label B, and new_data is the name of
the cell range A1:B2. Append the data in cell range A1:B2 to B:

MLAppendMatrix(Cl, new_data)

Al B1
A2 B2




MLAppendMatrix

B is now a 4-by-2 matrix with the data from A1:B2 in the last two rows.

More About
Tips

* MLAppendMatrix checks the dimensions of var_name and mdat to determine how
to append mdat to var_name. If the dimensions allow appending mdat as either new
rows or new columns, it appends mdat to var_name as new rows. If the dimensions do
not match, the function returns an error.

+ If mdat is not initially an Excel Range data type and you call the function from a
worksheet, MLAppendMatrix performs the necessary type coercion.

+ If mdat is not an Excel Range data type and you call the function from within a
Microsoft Visual Basic macro, the call fails. The error message ByReFf Argument
Type Mismatch appears.

See Also

MLPutMatrix

Introduced before R2006a
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MLAutoStart

Automatically start MATLAB

Syntax

MLAutoStart(flag)
MLAutoStart flag
out = MLAutoStart(flag)

Description

MLAutoStart(flag) sets automatic startup of the Spreadsheet Link and MATLAB
software. A change of state takes effect the next time an Excel session starts. Use this
syntax when working directly in a worksheet.

MLAutoStart flag sets automatic startup of the Spreadsheet Link and MATLAB
software. A change of state takes effect the next time an Excel session starts. Use this
syntax in a VBA macro.

out = MLAutoStart(flag) lets you catch errors when executing MLAutoStartin a
VBA macro. If MLAutoStart fails, then out is a string containing error code. Otherwise,
outis 0.

Input Arguments

flag

Either "'yes" or "'no"".

Specify ""'yes' to automatically start the Spreadsheet Link and MATLAB software every
time a Microsoft Excel session starts. Specify "'no" to cancel automatic startup of the

Spreadsheet Link and MATLAB software.

Default: ""'yes"



MLAutoStart

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Cancel Automatic Startup of Spreadsheet Link and MATLAB

Enter this command in a worksheet:

MLAutoStart(''no™)

Spreadsheet Link and MATLAB do not start on subsequent Excel session invocations.

More About
Tips

If Spreadsheet Link and MATLAB are running, then MLAutoStart(*'no') does not
stop them.

“Start Spreadsheet Link and MATLAB Automatically” on page 1-14

See Also
matlabinit | MLClose | MLOpen

Introduced before R2006a
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MLProgramid

Specify MATLAB version

Syntax

=MLProgramld(version)
MLProgramld version

Description

=MLProgramld(version) specifies the MATLAB version to open when Spreadsheet
Link starts in Microsoft Excel. Enter this syntax when working in a worksheet cell.

MLProgramld version specifies the MATLAB version. Enter this syntax when working
in a VBA macro.

Examples

Specify MATLAB Version in Worksheet Cells

Enter this text in any worksheet cell. This text sets the MATLAB version to 9.0, which
corresponds to MATLAB R2016a.

=MLProgramld(*'9.0"")
The worksheet cell displays O when MLProgramld runs.

To check that the preference is set, open the Preferences dialog box. The MATLAB
program id box contains 9.0. For details about the Preferences dialog box, see “Setting
Spreadsheet Link Preferences” on page 1-11.

Start MATLAB.
For troubleshooting, see “Startup Errors” on page 3-11.
Specify MATLAB Version in VBA Macro

Enter this text at the beginning of the VBA macro. This text sets the MATLAB version to
9.0, which corresponds to MATLAB R2016a.



MLProgramlid

MLProgramld "9.0"

Run the macro by clicking Run Macro (F5). For details about running macros, see Excel
Help.

To check that the preference is set, open the Preferences dialog box. The MATLAB
program id box contains 9.0. For details about the Preferences dialog box, see “Setting
Spreadsheet Link Preferences” on page 1-11.

Start MATLAB.

For troubleshooting, see “Startup Errors” on page 3-11.

Input Arguments

version — MATLAB version
string

MATLAB version, specified as a string to indicate which MATLAB version to open when
multiple versions are installed on the computer.

The Windows registry defines the MATLAB version number under . . . \Mathworks
\MATLAB. For example, MATLAB R2016a corresponds to version 9.0 in the registry.

Example: "'9.0"

More About

. “Setting Spreadsheet Link Preferences” on page 1-11
. “Startup Errors” on page 3-11

See Also
MLAutoStart | MLOpen

Introduced in R2016b
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MLClose

Stop MATLAB

Syntax
MLClose()

MLClose
out = MLClose()

Description

MLClose() ends the MATLAB process, deletes all variables from the MATLAB
workspace, and tells the Microsoft Excel software that the MATLAB software is no longer
running. Use this syntax when working directly in a worksheet.

MLClose ends the MATLAB process, deletes all variables from the MATLAB workspace,
and tells the Microsoft Excel software that the MATLAB software is no longer running.

Use this syntax in a VBA macro.

out = MLClose() lets you catch errors when executing MLClose in a VBA macro. If
MLCIlose fails, then out is a string containing error code. Otherwise, out is O.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

End the MATLAB Session

End the MATLAB session from a worksheet:



MLClose

MLClose()

More About
Tips
If you use MLClose when no MATLAB process is running, nothing happens.
“Stop Spreadsheet Link and MATLAB” on page 1-16

See Also
MLAutoStart | MLOpen

Introduced before R2006a
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MLDeleteMatrix

Delete MATLAB matrix

Syntax

MLDeleteMatrix(var_name)
MLDeleteMatrix var_name
out = MLDeleteMatrix(var_name)

Description

MLDeleteMatrix(var_name) deletes the named matrix from the MATLAB workspace.
Use this syntax when working directly in a worksheet.

MLDeleteMatrix var_name deletes the named matrix from the MATLAB workspace.
Use this syntax in a VBA macro.

out = MLDeleteMatrix(var_name) lets you catch errors when executing
MLDeleteMatrix in a VBA macro. If MLDeleteMatrix fails, then out is a string
containing error code. Otherwise, out is O.

Input Arguments

var_name
Name of MATLAB matrix to delete.

var_name in quotes directly specifies the matrix name. var_name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.



MLDeleteMatrix

Examples
Delete a Matrix from the MATLAB Workspace

Delete matrix A from the MATLAB workspace:

MLDeleteMatrix(""'A™)

See Also
MLAppendMatrix | MLGetMatrix | MLPutMatrix

Introduced before R2006a
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MLEvalString

Evaluate command in MATLAB

Syntax

MLEvalString(command)
MLEvalString command
out = MLEvalString(command)

Description

MLEvalString(command) passes a command string to the MATLAB software for
evaluation. Use this syntax when working directly in a worksheet.

MLEvalString command passes a command string to the MATLAB software for
evaluation. Use this syntax in a VBA macro.

out = MLEvalString(command) lets you catch errors when executing MLEvalString
in a VBA macro. If MLEval String fails, then out is a string containing error code or
error message. Otherwise, out is O.

Input Arguments
command
MATLAB command to evaluate.

command in quotes directly specifies the command. command without quotes specifies a
worksheet cell address (or range name) that contains the command.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code or error message.
To return MATLAB error messages instead of error code, use MLShowMatlabErrors.



MLEvalString

Examples

Evaluate a MATLAB Command from an Excel Worksheet
Divide the MATLAB variable b by 2, and then plot it:
MLEvalString("b = b/2;plot(b)')

This command only modifies the MATLAB variable b. To update data in the Excel
worksheet, use MLGetMatrix.

More About
Tips

The specified action alters only the MATLAB workspace. It has no effect on the
Microsoft Excel workspace.

If MLEval String fails, then by default you get a standard Spreadsheet Link error,
such as #COMMAND. To return MATLAB errors, use MLShowMatlabErrors.

See Also
MLGetMatrix | MLShowMatlabErrors

Introduced before R2006a
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MLGetFigure

Import current MATLAB figure into Microsoft Excel worksheet

Syntax

MLGetFigure(width,height)
MLGetFigure width, height
out = MLGetFigure(width,height)

Description

MLGetFigure(width,height) import the current MATLAB figure into an Excel
worksheet, where the top-left corner of the figure is the current worksheet cell. Use this
syntax when working directly in a worksheet.

MLGetFigure width, height import the current MATLAB figure into an Excel
worksheet, where the top-left corner of the figure is the current worksheet cell. Use this
syntax in a VBA macro.

out = MLGetFigure(width,height) lets you catch errors when executing

MLGetFigure in a VBA macro. If MLGetFigure fails, then out is a string containing
error code. Otherwise, out is O.

Input Arguments
width

Width (in normalized units) of the MATLAB figure when imported into an Excel
worksheet.

height

Height (in normalized units) of the MATLAB figure when imported into an Excel
worksheet.



MLGetFigure

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Import a MATLAB Figure into an Excel Worksheet

Import the current MATLAB figure into an Excel worksheet. Specify the width and the
height of the figure to be half those of the original figure:

MLGetFigure(.5, .5)

Note that if you use Microsoft Excel 2007 or 2010, the width and the height of the
imported figure will be a quarter of those of the original figure.

More About
Tips

+ If you use Microsoft Excel 2007 or 2010, MLGetFigure scales the imported figure by
the product of width and height along both dimensions.

+ If worksheet calculation mode is automatic, MLGetFigure executes when you
enter the formula in a cell. If worksheet calculation mode is manual, enter the
MLGetFigure function in a cell, then press F9 to execute it. Remember that pressing
F9 in this situation can also execute other worksheet functions again and generate
unpredictable results.

+ If you use MLGetFigure in a macro subroutine, enter MatlabRequest on the line
after the MLGetFigure. MatlabRequest initializes internal Spreadsheet Link
variables and enables MLGetFigure to function in a subroutine. Do not include
MatlabRequest in a macro function unless the function is called from a subroutine.

See Also
MLGetMatrix | MLGetVar
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Introduced in R2006b
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MLGetMatrix

Write contents of MATLAB matrix to Microsoft Excel worksheet

Syntax

MLGetMatrix(var_name,edat)
MLGetMatrix var_name, edat
out = MLGetMatrix(var_name,edat)

Description

MLGetMatrix(var_name,edat) writes the contents of MATLAB matrix var_name in
the Excel worksheet, beginning in the upper-left cell specified by edat. Use this syntax
when working directly in a worksheet.

MLGetMatrix var_name, edat writes the contents of MATLAB matrix var_name in

the Excel worksheet, beginning in the upper-left cell specified by edat. Use this syntax in
a VBA macro.

out = MLGetMatrix(var_name,edat) lets you catch errors when executing
MLGetMatrix in a VBA macro. If MLGetMatrix fails, then out is a string containing
error code. Otherwise, out is 0.

Input Arguments
var_name
Name of MATLAB matrix to access.

var_name in quotes directly specifies the matrix name. var_name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name. Do not
use the MATLAB variable ans as var_name.

edat

Worksheet location where the function writes the contents of var_name.
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edat in quotes directly specifies the location. edat without quotes specifies a worksheet
cell address (or range name) that contains a reference to the location. In both cases, edat
must be a cell address or a range name.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Specify the Matrix Name and Location Directly

Write the contents of the MATLAB matrix bonds starting in cell C10 of Sheet2. If
bonds is a 4-by-3 matrix, fill cells C10. .E13 with data:

MLGetMatrix(*'bonds", "'Sheet2!1C10™)
Specify the Matrix Name and Location Indirectly

Access the MATLAB matrix named by the string in worksheet cell B12. Write the
contents of the matrix to the worksheet starting at the location named by the string in
worksheet cell B13:

MLGetMatrix(B12, B13)
Use MLGetMatrix in a VBA Macro

Write the contents of MATLAB matrix A to the worksheet, starting at the cell named by
RangeA:

Sub Get_RangeAQ)
MLGetMatrix A", "RangeA"
MatlabRequest

End Sub

Use the Address Property of the Range Object to Specify Location

In a macro, use the Address property of the range object returned by the VBA Cells
function to specify where to write the data:



MLGetMatrix

Sub Get Variable()

MLGetMatrix "X, Cells(3, 2).Address
MatlabRequest

End Sub

Catch Errors in a VBA Macro

Use this function to get the variable A from MATLAB and to test if the command
succeeded:

Sub myfun()
Dim out As Variant

out = MLGetMatrix("A™, "Al'™)

IT out <> 0 Then
MsgBox out
End IFf
MatlabRequest
End Sub

If MLGetMatrix fails, myfun displays a message box with the error code.

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

More About
Tips

+ If data exists in the specified worksheet cells, it is overwritten.

+ If the dimensions of the MATLAB matrix are larger than that of the specified cells,
the data overflows into additional rows and columns.

+ edat must not include the cell that contains the MLGetMatrix function. In other
words, be careful not to overwrite the function itself. Also make sure there is enough
room 1n the worksheet to write the matrix contents. If there is insufficient room, the
function generates a fatal error.

+ MLGetMatrix function does not automatically adjust cell addresses. If edat is an
explicit cell address, edit it to correct the address when you do either of the following:

Insert or delete rows or columns.

Move or copy the function to another cell.
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+ If worksheet calculation mode is automatic, MLGetMatrix executes when you
enter the formula in a cell. If worksheet calculation mode is manual, enter the
MLGetMatrix function in a cell, and then press F9 to execute it. However, pressing
F9 in this situation may also execute other worksheet functions again and generate
unpredictable results.

+ If you use MLGetMatrix in a macro subroutine, enter MatlabRequest on the line
after the MLGetMatrix. MatlabRequest initializes internal Spreadsheet Link
variables and enables MLGetMatrix to function in a subroutine. Do not include
MatlabRequest in a macro function unless the function is called from a subroutine.

See Also
MLAppendMatrix | MLPutMatrix | MLPutRanges

Introduced before R2006a
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MLGetVar

Write contents of MATLAB matrix in Microsoft Excel VBA variable

Syntax

MLGetVar ML_var_name, VBA_ var_name

Description

MLGetVar ML_var_name, VBA_var_name writes the contents of MATLAB matrix
ML_var_name in the Excel Visual Basic for Applications (VBA) variable VBA_var_name.
Creates VBA_var_name if it does not exist. Replaces existing data in VBA_var_name.

Input Arguments
ML_var_name
Name of MATLAB matrix to access.

ML_var_name in quotes directly specifies the matrix name. ML_var_name without
quotes specifies a VBA variable that contains the matrix name as a string. Do not use
the MATLAB variable ans as ML_var_name. If defined, ML_var_name must be of type
VARIANT. Any other type will give a ""TYPE MISMATCH" error.

VBA_var_name
Name of VBA variable where the function writes the contents of ML_var_name.

Use VBA var_name without quotes.

Examples

Write the Contents of a MATLAB Matrix into a VBA Variable

Write the contents of the MATLAB matrix J into the VBA variable DataJ:
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Sub Fetch()
MLGetVar ''J', DataJd
End Sub

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

See Also
MLPutVar

Introduced before R2006a
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MLMissingDataAsNaN

Set empty cells to NaN or O

Syntax

=MLMissingDataAsNaN(flag)
MLMissingDataAsNaN flag
out = MLMissingDataAsNaN(flag)

Description

=MLMissingDataAsNaN(flag) sets empty cells to NaN or 0. When the Spreadsheet
Link software is installed, the default is "'no"’, so empty cells are handled as Os. If you
change the value of MLMissingDataAsNaN to "yes", the change remains in effect the
next time a Microsoft Excel session starts. Use this syntax when working directly in a
worksheet.

MLMissingDataAsNaN flag sets empty cells to NaN or 0. Use this syntax in a VBA
macro.

out = MLMissingDataAsNaN(Flag) lets you catch errors when executing

MLMissingDataAsNaN in a VBA macro. If MLMissingDataAsNaN fails, then outis a
string containing error code. Otherwise, out is O.

Input Arguments

flag

Either ""yes" or "'no"".

Specify ""'yes' to set empty cells to use NaNs. Specify "'no’" to set empty cells to use Os.

Default: "'no™
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Output Arguments
out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Set Empty Cells to Use Os

Cancel the use of the value NaN for empty cells:

=MLMissingDataAsNaN(*'no™)

More About
Tips

A string in an Excel range always forces cell array output and empty cells as NaNs.

See Also
MLPutMatrix

Introduced in R2007a
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MLOpen

Start MATLAB

Syntax
MLOpen()

MLOpen
out = MLOpen()

Description
MLOpen() starts MATLAB process. Use MLOpen to restart the MATLAB session after

you have stopped it with MLClose in a given Microsoft Excel session. Use this syntax
when working directly in a worksheet.

MLOpen starts MATLAB process. Use MLOpen to restart the MATLAB session after you
have stopped it with MLClose in a given Microsoft Excel session. Use this syntax in a
VBA macro.

out = MLOpen() lets you catch errors when executing MLOpen in a VBA macro. If
MLOpen fails, then out is a string containing error code. Otherwise, out is O.

Output Arguments
out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Start a MATLAB Session

Start a MATLAB session from a worksheet:
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MLOpen()

More About
Tips

If a MATLAB process has already started, subsequent calls to MLOpen do nothing.

To start a MATLAB session and initialize the Spreadsheet Link software, use
matlabinit rather than MLOpen.

See Also

matlabinit | MLClose

Introduced before R2006a
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MLPutMatrix

Create or overwrite MATLAB matrix with data from Microsoft Excel worksheet

Syntax

MLPutMatrix(var_name, mdat)
MLPutMatrix var_name, mdat
out = MLPutMatrix(var_name,mdat)

Description
MLPutMatrix(var_name, mdat) creates or overwrites matrix var_name in MATLAB
workspace with specified data in mdat. Creates var_name if it does not exist. Use this

syntax when working directly in a worksheet.

MLPutMatrix var_name, mdat creates or overwrites matrix var_name in MATLAB
workspace with specified data in mdat. Use this syntax in a VBA macro.

out = MLPutMatrix(var_name,mdat) lets you catch errors when executing

MLPutMatrix in a VBA macro. If MLPutMatrix fails, then out is a string containing
error code. Otherwise, out is O.

Input Arguments

var_name
Name of MATLAB matrix to create or overwrite.

var_name in quotes directly specifies the matrix name. var_name without quotes
specifies a worksheet cell address (or range name) that contains the matrix name.

mdat

Location of data to copy into var_name.
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mdat must be a worksheet cell address or range name. Do not enclose it in quotes.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Create or Overwrite a Matrix in the MATLAB Workspace

Create or overwrite matrix A in the MATLAB workspace with the data in the worksheet
range A1:C3:

MLPutMatrix A", Range("'Al1:C3')

Import Data from a Microsoft Excel Worksheet to the MATLAB Workspace Using the putmatrix
Toolbar Button

1 In the Excel worksheet, select the columns and/or rows you want to export to the
MATLAB workspace.

® - s

Home Insert Page Layout Formulas Data

startmatlab |putmatrix getmatrix evalstring getfigure wizard preferences

Custom Toolbars

3 1 2 3
4 4 3 5]

| ]
5

2 Click the putmatrix button on the Spreadsheet Link toolbar. A window appears
that prompts you to specify the name of the MATLAB variable in which you want to
store your data.



MLPutMatrix

-

Microsoft Excel

[l
Variable name in MATLAB

Cancel

3 Enter newmatrix for the MATLAB variable name.
4 Click OK.

Now you can manipulate newmatrix in the Command Window.

newmatrix
newmatrix =
1 2 3
4 5 6

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

More About
Tips

+ If var_name exists, this function replaces the contents with mdat.

*  Empty numeric data cells within the range of mdat become numeric zeros within the
MATLAB matrix identified by var_name.

+ If any element of mdat contains string data, mdat is exported as a MATLAB cell

array. Empty string elements within the range of mdat become NaNs within the
MATLAB cell array.

* When using MLPutMatrix in a subroutine, indicate the source of the worksheet data
using the Microsoft Excel macro Range. For example:

Sub test()
MLPutMatrix "a', Range("'Al1:A3")
End Sub
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If you have a named range in your worksheet, you can specify the name instead of the
range; for example:

Sub test()
MLPutMatrix "a'", Range(''temp'™)
End Sub

where temp is a named range in your worksheet.

See Also
MLAppendMatrix | MLGetMatrix | MLPutRanges

Introduced before R2006a
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MLPutRanges

Send data in Microsoft Excel named ranges to MATLAB

Syntax
= MLPutRanges()

MLPutRanges
out = MLPutRanges()

Description

= MLPutRanges() writes the named cell ranges in a Microsoft Excel worksheet into
MATLAB variables. The variables are named with the same name specified by the cell
range name in Microsoft Excel. To use this syntax, right-click in any Microsoft Excel cell
and enter this syntax and press Enter.

MLPutRanges writes the named cell ranges in a Microsoft Excel worksheet into
MATLAB variables. The variables are named with the same name specified by the cell
range name in Microsoft Excel. Use this syntax when working directly in a Microsoft
Visual Basic macro.

out = MLPutRanges() returns the named cell ranges in a Microsoft Excel worksheet
into MATLAB variables. The variables are named with the same name specified by the
cell range name in Microsoft Excel. In this case, out specifies whether the MLPutRanges
function executed successfully. Use this syntax when working directly in a Microsoft
Visual Basic macro.

Examples

Send Microsoft Excel Named Ranges to MATLAB in a Microsoft Excel Cell

Define a name for a range of cells. For instructions about defining names, see Excel
Help and enter the search term: define and use names in formulas.
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The name of the range of cells appears in the Name Box. In this example, the range

selected from cell Al to cell E1 is named testData.

-

-
X9~ ®-|= Bookl - Microsoft Excel Iilﬂ‘g
Home | Insert | Page Layc | Formulas | Data | Review | View | Develope | Add-Ins | & e o @ ER
= [ ibri - - = 1t - -
j & Calibri 11 o, A 5] T - A7 4
Paste =2 Number| Styles | Cells E %
g = 5 ner] Stles | Cells | 5. .
Clipboard ra Fant [F} Alignment Ta Editing MATLAB
testData - {_" I | 1 v
A | 8 | ¢ | o | E F G H 1L B
1 1 2 3 4 3 E|
2
3 w
4 4 » M| Sheetl ~'Sheet? - 'Sheet3 %1 4] i | [N
Ready | B3 | Average:3  Count:5 Sum:15 [[EE|EIM 100% (=) U (+) 4

Call the function inside a worksheet cell to send data in the named ranges in the current

worksheet to MATLAB.

= MLPutRanges()

| H9-wo-|= Bookl - Microsoft Excel

Home Insert | Page Layc | Formulas | Data

[=[m] = |

Review | View | Develope | Add-Ins | & 9 o e E2

(== j - - oy -
j * 11 o, &‘ Ej E -0 ‘
“—lEa- B 5O A -
Paste = - A A MNumber, Styles | Cells ﬂ #
o ; b ] A - - - Qv -
Clipboard ra Fant Editing MATLAE
SUM (" K .fr| =mlputranges() v
A B C D E F ] H [~
1 1 2 3 a 5 @
2 |=mlputranges(}
3 -
4 4 » M| Sheetl 'Sheet? ~Sheet3 ~¥J 4] il | [
Edit | =3 | |EB O 100% (- —




MLPutRanges

After pressing Enter, the range named testData is sent from Microsoft Excel to a
variable named testData in MATLAB.

Command Window & | Waorkspace ®
('?. Meww to MATLABT Wifatch this Video, see Exarnples, orre | Mame Walue Min Ml ax

> teatData ] testData [1,2,3,4,5] 1 5

testDhata =

Send Microsoft Excel Named Ranges to MATLAB in Microsoft Visual Basic Macro Without
Output

Call the function to send data in the named ranges in the current worksheet to MATLAB.

MLPutRanges
Send Microsoft Excel Named Ranges to MATLAB in Microsoft Visual Basic Macro with Output

Call the function to send data in the named ranges in the current worksheet to MATLAB.

out = MLPutRanges()

out returns 0 if the function succeeded or a string with the corresponding error code if
the function failed.

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

Output Arguments

out — Status
0 | string

Status for execution of MLPutRanges, returned as 0 if the function succeeded, or a string
containing an error code.
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See Also
MLGetMatrix | MLPutMatrix

Introduced in R2013b

4-40



MLPutVar

MLPutVar

Create or overwrite MATLAB matrix with data from Microsoft Excel VBA variable

Syntax

MLPutVar ML_var_name, VBA var_name
out = MLPutVar ML_var_name, VBA_var_name

Description

MLPutVar ML_var_name, VBA var_name creates or overwrites matrix ML_var_name
in MATLAB workspace with data in VBA_var_name. Creates ML_var_name if it does
not exist. If ML_var_name exists, this function replaces the contents with data from
VBA_var_name.

out = MLPutVar ML_var_name, VBA_ var_name lets you catch errors when executing

MLPutVar. If MLPutVar fails, then out is a string containing error code. Otherwise, out
is O.

Input Arguments

ML_var_name
Name of MATLAB matrix to create or overwrite.

ML_var_name in quotes directly specifies the matrix name. ML_var_name without
quotes specifies a VBA variable that contains the matrix name as a string.

VBA_var_name
Name of VBA variable whose contents are written to ML_var_name.

Use VBA_ var_name without quotes.
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Output Arguments
out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Create a MATLAB Matrix Using Data Stored in a VBA Variable

Create (or overwrite) the MATLAB matrix K with the data in the VBA variable DataK:

Sub Put(Q)
MLPutVar "K', DataK
End Sub

. “Work with MATLAB Functions in Microsoft Excel” on page 1-17

More About
Tips
+ Use MLPutVar only in a macro subroutine, not in a macro function or in a subroutine

called by a function.

*  Empty numeric data cells within VBA_var_name become numeric zeros within the
MATLAB matrix identified by ML_var_name.

+ If any element of VBA var_name contains string data, VBA_var_name is exported as
a MATLAB cell array. Empty string elements within VBA_var_name become NaNs
within the MATLAB cell array.

See Also
MLGetVar

Introduced before R2006a



MLShowMatlabErrors

MLShowMatlabErrors

Return standard Spreadsheet Link errors or full MATLAB errors using MLEvalString

Syntax

MLShowMatlabErrors(flag)
MLShowMatlabErrors flag
out = MLShowMatlabErrors(flag)

Description
MLShowMatlabErrors(flag) sets the Spreadsheet Link error display mode when
executing MATLAB commands using MLEval String. Use this syntax when working

directly in a worksheet.

MLShowMatlabErrors flag sets the Spreadsheet Link error display mode when
executing MATLAB commands using MLEvalString. Use this syntax in a VBA macro.

out = MLShowMatlabErrors(flag) lets you catch errors when executing

MLShowMatlabErrors in a VBA macro. If MLShowMatlabErrors fails, then out is a
string containing error code. Otherwise, out is O.

Input Arguments

flag

Either "'yes" or "'no"".

Specify ""'yes' to display the full MATLAB error message upon MLEvalString failure.
Specify "'no"* to display the standard Spreadsheet Link errors upon MLEvalString

failure.

Default: "'no"
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Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Switch to Displaying Spreadsheet Link Errors

Switch to displaying standard Spreadsheet Link errors, such as #COMMAND, on
MLEvalString failures:

MLShowMatlabErrors(*'no™)
Switch to Displaying MATLAB Errors

Switch to displaying MATLAB errors, such as ??? Undefined function or
variable "foo", on MLEvalString failures:

MLShowMatlabErrors(*'yes™)

See Also
MLEvalString

Introduced in R2006b
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MLStartDir

Specify MATLAB current working folder after startup

Syntax
MLStartDir(path)

MLStartDir path
out = MLStartDir(path)

Description

MLStartDir(path) sets the MATLAB working folder after startup. Use this syntax
when working directly in a worksheet.

MLStartDir path sets the MATLAB working folder after startup. Use this syntax in a
VBA macro.

out = MLStartDir(path) lets you catch errors when executing MLStartDir in a VBA
macro. If MLStartDir fails, then out is a string containing error code. Otherwise, out is
0.

Input Arguments

path

Path to the new MATLAB working folder after startup.

Output Arguments

out

0 if the command succeeded. Otherwise, a string containing error code.
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Examples

Specify MATLAB Working Folder

Set the MATLAB working folder to d:\work after startup:
MLStartDir (“d:\work’)

Specify MATLAB Working Folder That Includes Spaces

If your folder path includes a space, embed the path in single quotation marks within
double quotation marks.

Set the MATLAB working folder to d:z\my work:

MLStartDir (“"d:\my work"’)

More About
Tips

This function does not work like the standard Microsoft Windows Start In setting,
because it does not automatically run startup.m or matlabrc.m in the specified
folder.

The working folder changes only if you run MATLAB after you run this function.
Running this function while MATLAB is running does not change the working folder
for the current session. In this case, MATLAB uses the specified folder as the working
folder when it is restarted.

See Also
MLAutoStart

Introduced in R2006b
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MLUseCellArray

Toggle MLPutMatrix to use MATLAB cell arrays

Syntax

MLUseCellArray(flag)
MLUseCellArray flag
out = MLUseCellArray(flag)

Description

MLUseCellArray(flag) specifies whether MLPutMatrix must use cell arrays for
transfer of data (for example, dates). When the Spreadsheet Link software is installed,
the default is "'no". If you change the value of MLUseCel lArray to "'yes", the change

remains in effect the next time a Microsoft Excel session starts. Use this syntax when
working directly in a worksheet.

MLUseCellArray flag specifies whether MLPutMatrix must use cell arrays for
transfer of data. Use this syntax in a VBA macro.

out = MLUseCellArray(flag) lets you catch errors when executing

MLUseCellArray in a VBA macro. If MLUseCel IArray fails, then out is a string
containing error code. Otherwise, out is O.

Input Arguments
flag
Either ""yes" or "no".

Specify ""'yes' to automatically uses cell arrays for transfer of data structures. Specify
""no" to stop using cell arrays for transfer of data structures.

Default: "'no™
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Output Arguments
out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Stop Using Cell Arrays When Transferring Data Structures

Cancel automatic use of cell arrays for easy transfer of data:

MLUseCellArray(''no™)

See Also
MLPutMatrix

Introduced in R2007a
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MLUseFullDesktop

Specify whether to use full MATLAB desktop or Command Window

Syntax
MLUseFul IDesktop(flag)

MLUseFul IDesktop flag
out = MLUseFullDesktop(flag)

Description

MLUseFul IDesktop(Fflag) sets the MATLAB session to start with the full desktop or
Command Window only. Use this syntax when working directly in a worksheet.

MLUseFul IDesktop flag sets the MATLAB session to start with the full desktop or
Command Window only. Use this syntax in a VBA macro.

out = MLUseFullDesktop(Fflag) lets you catch errors when executing

MLUseFul IDesktop in a VBA macro. If MLUseFul 1Desktop fails, then out is a string
containing error code. Otherwise, out is O.

Input Arguments

Default:
flag
Either "'yes" or "'no".

Specify ""'yes' to start full MATLAB desktop. Specify "'no" to start the Command
Window only.

Default: ""'yes"
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Output Arguments
out

0 if the command succeeded. Otherwise, a string containing error code.

Examples

Start Only the Command Window

Set the MATLAB session to start with the command window only:

MLUseFul IDesktop(*'no'™)

See Also
matlabinit | MLClose | MLOpen

Introduced in R2006b
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